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1.  Overview
The CATC SATracer/Trainer™ SATA protocol analyzer provides fast, 
efficient and accurate debug, test and verification of Serial ATA 
semiconductors, devices, and systems.  

Effective Serial ATA analysis requires non-intrusive recording at both 1.5 
and 3 Gbps line-rate with native support for spread spectrum clocked (SSC) 
signals. CATC's 4th Generation SATA analyzer utilizes production level 
transceiver silicon designed to be fully compatible with Serial ATA-II. It 
displays traffic using CATC's Expert Analysis Software to provide 
unsurpassed ease of use and understanding for Serial ATA communications. 

1.1  Analyzer Hardware 
SATracer is a hardware plug-in module that installs into the CATC 
Universal Protocol Analyzer System (UPAS 10000). The UPAS 10000 is 
CATC's highest bandwidth platform intelligently designed to support other 
technologies by plugging different protocol-specific modules into the 
chassis. Affordable plug-ins are available for Fibre Channel, PCI-Express 
and InfiniBand. The SATracer system can also be upgraded with software 
to support Serial Attached SCSI (SAS). 

The heart of the UPAS platform is the revolutionary CATC BusEngine™. 
This state-of-the-art protocol processor core incorporates a real-time 
recording engine and configurable tools to effectively monitor Serial ATA 
traffic at full line rate. All BusEngine logic is fully field-upgradeable. 

CATC's SATracer analyzer module plug-in utilizes production level 
transceiver silicon designed to be fully compatible with Serial ATA-II. It 
triggers and records the critical out-of-band (OOB) signaling, supports SSC 
and displays SATA-II negotiated link speeds. A Hi-Speed USB port is used 
to upload Serial ATA traffic to the host PC. 

SATracer comes with trace viewer software that can be installed on PCs as 
a stand-alone viewer to view Serial ATA data recorded by other SATracer 
analyzers, thereby giving engineers a vehicle for sharing trace data and 
resolving problems encountered in the trace.

1.2  Spread Spectrum Clocking
SATracer version 1.4 and above can record traffic from Serial ATA devices 
that  utilize spread spectrum clocked (SSC) signaling.  SSC modulates the 
operating frequency of a circuit slightly to spread its radiated emissions over 
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a range of frequencies rather than just one tone. By distributing emissions 
for a given frequency, SSC transmissions help devices meet FCC 
requirements. 

SSC transmission is optional on the transmitter (TX) side for both host and 
device. However, SSC is a mandatory capability for all Serial ATA 
receivers (RX). This requirement eliminates compatibility issues by 
ensuring that all devices can tolerate SSC signals when attached to a device 
that transmits SSC signaling.

SSC is accomplished by "down-spreading" 
the clock frequency using a deviation of no 
more than 0.5% down-spread (+0% -0.5%) 
D = peak reduction
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Please refer to the Serial ATA Specification for details on the Serial ATA 
protocol. The Serial ATA specification is available from the Serial ATA at 
its web site http://www.serialata.org.

1.3  General Description 
SATracer/Trainer is a plug-in module that installs into a chassis called the  
Universal Protocol Analyzer System 10000 (UPAS 10K).  The UPAS 10K, 
in turn, connects to a PC over a Hi-Speed USB cable. The PC functions as 
the host controller for the SATracer and UPAS.  SATracer software on the 
PC controls and configures the analyzer and retrieves and displays trace 
data. 

Recorded data is presented as a "trace" in the trace viewer as rows of 
color-coded graphics. Users can then search this trace for errors and other  
events using advanced search utilities, and then hide from the display all but 
only the most interesting and relevant data. 

The SATracer/Trainer trace viewing software runs on any personal 
computer using the Windows 98SE, Window 2000, Windows ME, or 
Windows XP operating systems and equipped with a functional USB 
interface. 
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The SATracer/Trainer analyzer is capable of on-the-fly detection of and 
triggering on such events as Primitives, Bus Conditions, FIS, Data Patterns, 
and Errors. Whether recording manually or with a specified trigger 
condition, SATracer/Trainer continuously records the link data in a 
wrap-around fashion until manually stopped or until the Trigger Event is 
detected and a specified post-Trigger amount of link data is recorded.

Upon detection of a triggering event, the analyzer continues to record data 
up to a point specified by the user. Real-time detection of events can be 
individually enabled or disabled to allow triggering on events as they 
happen. This includes predefined exception or error conditions and a 
user-defined set of trigger events. 

The SATracer/Trainer software provides powerful search functions that 
enable investigation of particular events and allow the software to identify 
and highlight specific events. In addition to immediate analysis, you can 
print any part of the data. Use the Save As feature to save the data on disk 
for later viewing. The program also provides a variety of timing information 
and data analysis reports.
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1.4  Features 

SATracer Plug-in Module Hardware
• SATracer Analyzer records and analyzes GB Serial ATA traffic

• SATracer plug-in module designed for the CATC Universal Protocol 
Analyzer System (UPAS)

• Taps between host and device using standard connectors and cables

• Two GByte recording capacity to capture long time windows for analysis 
and problem solving

• Field-upgradeable firmware and recording engine with upgrades 
available for download direct from CATC

• External Breakout board for triggering from external signals or for 
triggering to external equipment

SATrainer Plug-in Module Hardware
• Integrated Analyzer and Generator system - all in one platform transmits, 

records, and analyzes Serial ATA protocol

• Serial ATA I compliant Host and Device Emulation serves as flexible 
platform for testing both host and devices

• Transmit Legal and illegal Serial ATA traffic - create framing and code 
errors

• Manual error injection for testing and debugging real-world fault 
handling

• Operates in both single-burst and continuous transmission modes for 
configuring generator for real-time or overnight stress testing

• Recreate problems reported in the field using only a sample CATC trace 
capture file - validate interoperability and compatibility with 
pre-production hardware that has limited availability

Software
• Industry-standard CATC Trace user interface

• Accurately time-stamped, easy visualization of bi-directional sequence 
between transmitter and receiver

• Turns an unintelligible stream of primitives into color-coded, clearly 
labeled protocol elements

• Collapsible and expandable headers with tool tip explanations make it 
easy to navigate and interpret sequence contents, headers, and commands
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• Export any trace file to create test patterns for the Generator - quickly and 
easily assemble sequences of primitives to emulate a variety of real world 
traffic conditions

• Online help

Recording Options
• UPAS 10K systems record up to 2 GB of Serial ATA data, timing and 

control information.  UPAS 2500H systems records up to 512 MB

• Three recording modes:  snapshot, manual trigger, and event trigger

• Selectable recording buffer size and trigger position

• UPAS 10K systems record the full data rate of a single 1.5 or 3.0 Gbit/sec 
Serial ATA link.  UPAS 2500H records 1.5 Gbit/sec

• Trigger on Serial ATA conditions like Bus Conditions, Primitives, FIS, 
Errors, and Data Patterns

• Trigger on a comprehensive list of error conditions like running 
disparity, or FIS errors 

• UPAS 2500H can trigger on sequences of up to six events

• Programmable triggering based on bit-wise pattern matching of Serial 
ATA headers and data payloads

Display Options
• Extensive use of color and graphics within the trace

• The base level traffic unit is a Sequence, which is a CATC-defined term 
for a serial stream of primitives and data transmitted from a host to a 
device or vice versa.

• Sequence, FIS, and Command errors and protocol violations are 
highlighted in red

• Sequence color clearly indicates position before or after the trigger point

• Sequences can be marked with text annotations that become tool tips for 
future reference

• Tool tips with complete definitions of most fields

• Search, show or hide only the data of interest using Serial ATA-specific 
criteria

• Sequences, FISs, and Commands are accurately time-stamped (26.67 ns 
resolution)

• Measure time, throughput or total data payload between Sequence, FIS, 
and Command markers or relative to the trigger position
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SATracer/Trainer BusEngine 
CATC’s BusEngine™ Technology is at the heart of the new 
SATracer/Trainer Analyzer. The revolutionary BusEngine core uses FPGA 
technology and incorporates both the real-time recording engine and the 
configurable building blocks that implement data/state/error detection, 
triggering, external signal monitoring, and event counting and sequencing. 
Like the flash-memory-based firmware that controls its operation, all 
BusEngine logic is fully field upgradeable, using configuration files that can 
be downloaded from the CATC Website. 

Power Cord Set
Cord Manufacturer and Models:

180-0005-00 Quail 5000.079 UL,CSA

180-0013-00 Quail 8500.098 VDE, KEMA, CEBERC, NEMDO, DEMDO, SETI,
OVE, SEV 

180-0014-00 Quail 9650.098 ASTA

UPAS 10000 and 2500H Platforms
UPAS 10K and 2500H are USB 2.0 Certified Hi-Speed Devices.  To upload 
traces from the UPAS/SATracer to an attached PC at Hi-Speed, the PC must 
have a USB 2.0 Certified Host Controller and be running Windows 2000 
SP3 or Windows XP.

Note The UPAS 10K and 2500H products include 2.0 USB hubs.You 
might see the drivers for these generic hubs being installed upon 
the initial plug-in.
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2.  Installation
SATracer/Trainer is a factory-installed module that is sold as part of the 
Universal Protocol Analyzer System (UPAS).

This chapter describes how to set up SATracer/Trainer and create your first 
recording.

2.1  System Components/Packing List
• One stand-alone SATracer/Trainer Analyzer module
• One USB cable

• Two Serial ATA cables

• SATracer software program CD-ROM

• Breakout board

• DB-25 Cable

• User Manual

2.2  Analyzer PC Requirements
SATrainer/Tracer connects to a Host PC.  The Host PC needs to meet the  
requirements outlined in the readme file on the Installation CD.

2.3  Analyzer LED Descriptions
The installed SATracer/Trainer analyzer module occupies the left slot on 
the CATC Universal Protocol Analyzer System (UPAS).  When powered 
on, the SATracer activates the user-accessible controls and LEDs on the 
front and rear panels of the UPAS.

Warning Do not open the UPAS enclosure.  There are no operator serviceable 
parts inside.  Refer servicing to CATC.

Figure 1:  Front Panel of UPAS 2500H System with SATracer Module.
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UPAS LEDs (from left to right)

• Green PWR (power) indicator LED for UPAS - lights when the unit 
power is switched on.

• Red Status indicator LED for UPAS - lights during initialization/power 
up of UPAS base unit. Blinks if a self-test fails.

The following LEDs and the Manual Trigger button on the UPAS 
enclosure under the left module slot function in conjunction with the 
SATracer module inserted above it.  

• Green REC (recording) LED - lights when the unit is recording.

• Orange TRG (triggered) LED - lights when the unit triggers on an event.

• Green UPLD (Upload) - lights when unit is uploading data to PC.

• The Manual Trigger push-button - allows a manual Trace capture.

LEDs and Connectors on the SATracer Module

• Green Status LED (Illuminates when there is traffic on both the host and 
device side of the bus).

• Serial ATA Connectors (2).

2.4  Rear Panel Description
From left to right, the UPAS rear panel contains the following components:

Figure 2:  Rear Panel 

USB type “B” host computer connector
This connector links the analyzer to the Host PC. for the purpose of 
transmitting commands from the PC to the analyzer and uploading traces 
from the analyzer’s recording memory to the SATracer software for 
viewing and analysis.

RS-232 25 pin "Data Output" Connector
This connector links a 25 pin RS-232 cable to an external breakout board.  
The breakout board allows signals to be sent from the analyzer to an external 
device such as an oscilloscope or from an external device to the analyzer for 
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the purpose of triggering on an external input.  You configure input/output 
signalling through the Recording Options dialog box.  Breakout board use 
is described at the end of this chapter.

BNC Connectors "Ext. In" and "Ext. Out"
These connectors allow BNC cables to be attached to the analyzer for the 
purpose of triggering on external input signals or for sending an output 
signal from the analyzer to another device.  These connectors have the same  
function as the 25 pin RS-232 connector - i.e., they channel input and output 
signals but do not support the use of a breakout board.  

Wide range AC connector module
— Power socket

— Power on/off switch

— Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning For continued protection against fire, replace fuse only with the type 
and rating specified above.

2.5  Setting Up the Analyzer
The following steps show the installation procedure for the SATracer on a 
UPAS 2500H system.  The installation steps for the UPAS 10K are 
essentially the same.

Step 1 Remove the SATracer/Trainer/UPAS from its shipping container.  

The SATracer/Trainer module will already be installed in the left 
slot.  The right slot will have a memory module installed in order to 
run the BusEngine and Firmware. 

Previous versions of SATracer have a blank face plate that covers 
the right slot bay, which should be left in place to facilitate proper 
airflow and venting.

Step 2 Connect the Analyzer unit to a 100-volt to 240-volt, 50 Hz to 60 Hz, 
120 W power outlet using the provided power cord. 

Note: The Analyzer is capable of supporting supply voltages between 
100-volt and 240-volt, 50 Hz or 60 Hz, thus supporting all 
known supply voltages around the world.

Step 3 Turn on the power switch on the rear of the UPAS.  
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Note: At power-on, the analyzer initializes itself in approximately ten 
seconds and performs an exhaustive self-diagnostic that lasts 
about five seconds.  The Status LED of the UPAS base unit turns 
red on power up/initialization.  The LED remains on 
approximately 25 seconds while the analyzer performs 
self-diagnostic testing. If the diagnostics fail, the Status LED 
will blink red, indicating a hardware failure. If this occurs, call 
CATC Customer Support for assistance. 

Step 4 Insert the CD into the CD ROM drive of the PC that will be 
controlling the analyzer.

Step 5 Connect the USB cable between the USB port on the back of the 
analyzer and a USB port on the PC.

The host operating system detects the analyzer and begins to install the USB 
driver.

Step 6 Follow Windows on-screen Plug-and-Play instructions for the 
automatic installation of the analyzer as a USB device on the Host 
PC (the required USB files are included on the SATracer CD). Step 
through the Windows hardware wizard.  The wizard will see that the 
UPAS has an internal USB hub and will begin loading hub drivers. 
Afterwards, the wizard will automatically install SATracer/Trainer 
as a USB device on the PC.  When the wizard prompts you for driver 
information, point it to the CD which should be in your disk drive 
and install catcupa.sys and SATracer.sys.

2.6  Installing the SATracer/Trainer Software
Once SATracer has been recognized as a USB device, install the 
SATrainer/Tracer software on the Host PC.

Step 1 On the PC, run setup.exe on the installation CD and follow the 
on-screen instructions.

The SATrainer/Tracer software will install on the PC hard disk.

Step 2 To start the application, launch the CATC SATracer program from 
the Start menu:  
Start > Programs > CATC > SATracer.
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The SATrainer/Tracer program opens. 

Note: The software may be used with or without the analyzer.  When 
used without an analyzer, the program functions as a Trace 
Viewer to view, analyze, and print captured traffic. 

2.7  Making a Serial ATA Recording
After installation, the software is configured to make a four-Mbyte snapshot 
recording of your Serial ATA traffic. 

To make this recording, follow these steps:

Step 1 Connect a cable to each of the two connectors on the 
SATracer/Trainer module, then connect the other ends to the Serial 
ATA device under test and Serial ATA host system.

Step 2 From the Setup menu, select Recording Options.

Step 3 Select the General tab. 
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The following window displays the factory default settings such as 
“Snapshot” and 16 Mbytes buffer size are displayed. For your first 
recording, you can leave these settings unchanged.

Step 4 Click  on the Tool Bar. After 16 Mbyte of traffic is recorded, the 
SATracer/Trainer Analyzer uploads the data and displays the 
sequences.

Stopping a Recording
You can stop the recording process at any time by pressing .  
Afterwards, the following dialog box opens: 

This dialog presents options for stopping, continuing, or aborting the 
recording:
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• Stop - Stops the recording and then displays the trace on screen.

• Continue - Resumes the recording.

• Flush - Cancels the recording without saving or displaying the 
trace.

When the recording session is finished, the bus traffic is uploaded to the PC 
and is automatically saved to the hard drive as a file named data.sat or the 
name you assign as the default filename. 

Step 5 To save a current recording for future reference, select 
Save As from the File menu.

Step 6 Give the recording a unique name and save it to the appropriate 
directory.

2.8  External Interface Breakout Board
With each analyzer, CATC includes an External Interface Breakout Board 
for accessing several potentially useful standard, LV TTL output and input 
signals. The breakout board also offers a simple way to connect logic 
analyzers or other tools to the SATracer/Trainer Analyzer unit. Six ground 
pins and one 5-volt pin are provided.

The Breakout Board connects via a cable to the Data In/Out connector 
located on the rear of the analyzer unit. Each signaling pin is isolated by a 
100Ω series resistor and a buffer inside the Analyzer unit. 

Data In/Out Connector (on cable)
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Pin-Outs for the Data In/Out Connector
The following table lists the pin-out and signal descriptions for the Data 
In/Out connector on a cable that connects to the Breakout board.   

Data In/Out Connector – Pin-Out

Note: (*) Pins 4 and 17 have the same function: they allow external 
signals to be used to cause triggering or recording. Pins 3 and 16 
are used to transmit output signals. Pins 6, 7, 8, 9, 18, 19, 21, and 
22 (data pins) are used to define data patterns for external input 
signals. See External Input Signals in Chapter 6. 

Pin Signal Name Signal  Description

1 RSV Reserved

2 GND Ground

3 GP OUT General Purpose Output

4 TRG IN 1 Trigger In 1

5 GND Ground

6 DATA 6 Data 6

7 DATA 4 Data 4

8 DATA 3 Data 3

9 DATA 1 Data 1

10 GND Ground

11 RSV Reserved

12 RSV Reserved

13 +5V +5 Volts, 250 mA DC Source

14 RSV Reserved

15 GND Ground

16 TRG OUT Trigger Out

17 TRG IN 0 Trigger In 0

18 DATA 7 Data 7

19 DATA 5 Data 5

20 GND Ground

21 DATA 2 Data 2

22 DATA 0 Data 0

23 GND Ground

24 RSV Reserved

25 RSV Reserved
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External Interface Breakout Board

Prototype Rework Area
The Breakout Board contains a prototype rework area for making custom 
circuits for rapid development. The area consists of plated-through holes, 20 
columns wide by 27 rows long. The top row of holes is connected to GND 
and the bottom row is connected to +5V. The remaining holes are not 
connected. Use the rework area to insert custom components and wire-wrap 
their respective signal, power, and ground pins. 

Configuring the Analyzer for the Breakout Board
To configure the analyzer for the breakout board, see  "External Input 
Signals" on page 89,  "Setting External Output Options" on page 113, and 
"Specifying Pulse Signal Outputs" on page 114.
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3.  Updates
From time to time as modifications are made to the SATracer/Trainer 
Analyzer, it may become necessary to update the SATracer/Trainer 
software.  You can obtain new software from the CATC website:  

www.catc.com  

When you download new SATracer software, firmware and BusEngine files 
are included as part of the software package.  Occasionally, CATC will 
update these files.  The new files will install automatically following 
installation of the new analyzer software.  If you prefer, however, you can 
manually update firmware and BusEngine. This chapter describes both 
automatic and manual updates.

Note: CATC analyzers come with a Three Year Investment Protection 
Agreement that entitles users to new software.  Thereafter, to 
obtain new software the user will need to renew the CATC 
Maintenance Agreement.  Contact CATC for details.

3.1  Software, Firmware, and BusEngine Versions
The Readme.txt file on the installation CD and on the installed directory on 
your hard drive.  This file gives last-minute updates about the current 
release. Included with each release are the most recent downloadable 
images of the Firmware and the BusEngine. 

Once the SATracer/Trainer Analyzer has completed the self diagnostics 
and is connected to the PC, you can check the latest version of the software 
and BusEngine.

To check information about the current software, select 
About SATracer… from the Help menu.

The About SATracer window appears.

About SATracer details revisions of the following software and hardware:

• SATracer/Trainer Software Version

• SATracer/Trainer Firmware Version

• BusEngine Version

• Unit Serial Number

Note: When contacting CATC for technical support, please have available 
all the revisions reported in the About SATracer window.
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3.2  Software Updates
When a new software release is available, it is posted on the Support page 
of the CATC website at www.catc.com/support.html.

To update the software, follow these steps:

Step 1 Find the latest released software version on the CATC website under 
Support.

If you are running the latest version of the software, no further 
action is needed. 

If you are not running the latest version, continue to Step 3.

Step 2 Download the Zip file from the website.

Step 3 Unzip the files into your choice of directory.

Step 4 Click Start, then Run, and browse to where you unzipped 
the files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the 
installation.

Step 8 Read the Readme file for important information on changes 
in the release.
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3.3  Automatic BusEngine and Firmware Updates
BusEngine and Firmware updates often need to be performed when you 
update the SATracer/Trainer software. These updates can be performed 
automatically or manually. Both processes are described.

Updating the BusEngine

The BusEngine core is the heart of the SATracer/Trainer Analyzer. Using 
FPGA technology, it incorporates both the high speed recording engine and 
the configurable building blocks that implement data/state/error detections, 
triggering, capture filtering, external signal monitoring, and event counting 
and sequencing. Both the BusEngine program and the Firmware that 
manages the internal microcontroller are fully field updateable.

Within a new software release, it may be necessary to update the Analyzer’s 
BusEngine hardware for proper operation. The Readme file lets you know 
if this is necessary. 

Updating the Firmware

Within a new software release, it may also be necessary to update the 
Analyzer’s firmware for proper operation. The Readme file informs you if 
this is necessary. 

Automatic Updates

When the SATracer/Trainer software is updated, the software may become 
incompatible with the BusEngine and Firmware. If a recording is attempted, 
SATracer/Trainer displays an error message and then automatically begins 
an update process for the BusEngine and Firmware. 

To perform an automatic BusEngine and Firmware update, follow these 
steps: 

Step 1 If needed, update the SATracer/Trainer software, following the 
steps outlined in "Software Updates."

Step 2 Turn on the SATracer/Trainer Analyzer.

Step 3 From the Record menu, select Start. 

Because the BusEngine and/or the Firmware are incompatible with 
the current SATracer/Trainer software version, an error message 
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appears showing your current versions and indicating what versions 
you need to install.

Step 4 Click Yes.

The Analyzer Setup window appears.

Step 5 Click Update BusEngine or Update Firmware.

You can select only one item at this point. If both the BusEngine 
and the Firmware need to be updated, the update will complete for 
the first item and then return to the above window so the second 
update can be performed. 

When the second update has finished, the following message 
appears and tells you that the update is complete. 

Step 6 To complete the update, power cycle the SATracer/Trainer 
(turn the unit off then back on).
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If you are running Windows 2000, the Analyzer will automatically 
reboot, and the following message will appear:

Step 7 Click OK.

In this instance, you do not need to power cycle the Analyzer (turn 
off then back on). 
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3.4  Manual BusEngine and Firmware Updates
The BusEngine and Firmware can be manually updated.  This section 
describes the procedure.

Updating the BusEngine
Within a new software release, it might be necessary to update the 
SATracer/Trainer Analyzer’s BusEngine hardware for proper operation. 
The Readme file informs you if updating SATracer/Trainer is necessary. 
Normally, the BusEngine is updated automatically following a software 
update. 

To manually update the BusEngine, follow these steps:

Step 1 From the Setup menu, select Analyzer.

Step 2 In the Analyzer Setup window, click Update BusEngine.

The Select engine file to download window appears.
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The program has already automatically searched for the correct file, 
and it is displayed in the File name field.

Note: The most current Primary BusEngine file (SATracer.rbf) was 
copied to your \CATC\SATracer directory when you installed the 
program. 

Step 3 Click Open.

Note: Once you have started updating the BusEngine, do not interrupt 
the update!

Updating the Firmware
Within a new software release, it may also be necessary to update the 
SATracer/Trainer Analyzer’s firmware for proper operation. The Readme 
file informs you if this is necessary. 

To update the firmware, follow these steps:

Step 1 Click Update Firmware on the Analyzer Setup screen.

The Select the firmware file to download window appears.

The program has already automatically searched for the correct file 
and displays it in the File name field.

Step 2 Click Open.

The SATracer/Trainer Analyzer updates the Firmware.

Step 3 Unplug the Serial ATA cable from the back of the 
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SATracer/Trainer Analyzer unit and then reinsert it so the 
new Firmware update can take effect.

Note: Once you have begun updating the Firmware, do not interrupt 
the update!

3.5  Resetting the Analyzer
The Analyzer Setup window contains a reset button at the top of the 
window. Its function is the equivalent of power cycling the Analyzer. 

Once the Reset Analyzer button has been pressed, SATracer/Trainer takes 
about 25 seconds to reinitialize. During this time the UPAS Status LED is 
on, indicating that power-on diagnostics are being run. If there is a hardware 
failure, the Trigger LED will blink after initialization is complete. If this 
occurs, contact CATC for customer support.
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4.  Software Overview
The SATracer/Trainer is an application that may be used with or without 
the SATracer/Trainer Analyzer unit. When used without an 
SATracer/Trainer Analyzer unit, the program functions in a Trace Viewer 
mode to view, analyze, and print captured protocol traffic from 
SATracer/Trainer Analyzers.  

4.1  Starting the SATracer/Trainer Program
To start the SATracer/Trainer Program from the Start menu,

Step 1 Click Start.

Step 2 Select Programs.

Step 3 Select CATC.

Step 4 Click CATC SATracer. 

4.2  Application Preferences ...
For those running SATracer on the UPAS 10K platform, you can skip this 
section.  The SATracer software supports by default the UPAS 10K 
platform.  If you are running SATracer software with a UPAS 2500H, the 
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analyzer software will detect by default the type of UPAS that is running 
(i.e., the 10K or the 2500H) and load the options associated with attached 
platform.  If you run SATracer software in 2500H mode without the 
analyzer, you can configure the software for the 2500H by selecting:

Setup > Application Preferences ...  then de-select the option  If no 
analyzer is connected, use UPAS 10K recording options.

This option affects the Recording Options dialog box.  See the Recording 
Options chapters for details.

4.3  Tool Tips
Throughout the application, Tool Tips provide useful information.

To display a Tool Tip, position the mouse pointer over 
an item of interest such as part of the trace or a button.  

4.4  Pop-up Tool-Tips
Many fields within the Trace will display pop-up tool-tips when the mouse 
pointer is suspended over them.  These tips provide added details about the 
field. 

4.5  The Menu bar
While some of the analyzer’s main display window options are familiar, 
many contain options specific to the analyzer program.

Note - The Generate menu is specific to SATrainer and is visible only 
when a File Generator file (*stg) is open in the Trace view.
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Table 1: Main Display Pull-Down Menus
Menu Function

File
Open… Opens a file.

Close Closes the current file.

Save As… Saves all or a specified range of Sequences from the current file with a 
specified name.

Print… Prints part or all of the current traffic data file.

Print Preview Produces an on-screen preview before printing.

Print Setup… Sets up your current or new printer.

Edit Comment… Creates or edits the Trace file comment field.

Export>> Sequences to Text (Sequence View Format) - Saves all or part of a 
Trace to a text file.

Data - Allows transfer data to be exported as text or a binary file.

8b/10b - Allows raw data to be saved to a spreadsheet/database format 
(.csv - Comma Separated Value)

Sequences to Traffic Generator Text File (.stg)... - Creates an .stg file 
that allows SATrainer to generate traffic

Comma Separated Value > New - Creates a new .csv file.  The process 
takes two steps:  1) Select fields from the trace for inclusion in a .csv 
file - this step creates a template; 2) create the new .csv file.

                                       > Open - Opens a template of previously selected 
fields and then exports the open trace file data to that template

Commands to iPeak (.raw) - Exports data to a format compatible with 
Intel’s iPeak performance-measuring software

Exit Exits the SATracer/Trainer program.

Setup
Display Options… Configuration dialog for setting color, formats, and filter options.

Recording 
Options…

Configuration dialog for setting recording, triggering, & filtering 
options.

Application 
Preferences

Opens a dialog box for selecting the SATracer software interface that 
will be used  and for setting how Commands will be sorted any time 
they appear in  a menu or list.  By default, the UPAS 10000 interface is 
selected.  This interface differs from the UPAS 2500H interface in the 
types of pages present in the Recording Options dialogs. 

Analyzer… Updates the BusEngine and Firmware.

Host Port 
(Transmit) > 
   AC Coupled
   DC Coupled

Retransmits the signal through the analyzer to the host in AC or DC 
Coupled mode.

Device Port 
(Transmit) > 
   AC Coupled
   DC Coupled

Retransmits the signal through the analyzer to the device in AC or DC 
Coupled mode.
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Record
Start Causes the Analyzer to begin recording Serial ATA activity.

Stop Causes the Analyzer to stop recording.

Use Partial 
Uploading

Enables Partial Uploading, an option for uploading a portion of the 
analyzer’s buffer to the PC.  This option lets you set the size and 
location of the analyzer’s buffer for uploading (for example, a few MB 
before and after the trigger event).  This option is useful with large 
recordings where uploading can take several minutes. If disabled, the 
full recording will upload before it can be decoded and analyzed.

Generate (This menu appears when a traffic generation file is loaded.)

Start/Stop Start/Stop File Generation for SATrainer.

Connect Connect Traffic Sequence.

Disconnect Disconnect Traffic Sequence.

Report
File Information Displays information about the recording such as the number of 

sequences and triggering setup.

Error Summary Summarizes the errors throughout the recording. Allows for fast 
navigation to errors.

Timing Calculation Calculates timing between two Sequences.

Traffic Summary Summarizes the numbers and types of Sequences, Primitives, FIS 
types, Commands, and errors that occurred in the open Trace.

Bus Utilization Displays graphs of various types of events that occurred in the open 
trace.  

View Data Opens a window that displays data for the selected FIS or Command

Search
Go to Trigger Positions the display to show the Trigger event.

Go to Sequence/FIS
/Command ...

Positions the display to the indicated Sequence, FIS, or Command.

Go to Marker » Positions the display to the selected marked Sequence.

Go to Time ... Opens a "Go to" dialog box and repositions the display to the selected 
Time.

Go to » Enables quick searching for specific events using a cascade of pop-up 
windows.

Find ... Allows searches by multiple criteria.

Find Next Looks for the next instance of an event specified with Goto or Find.

Search Direction Allows the search direction to be changed from forward to backwards 
or backwards to forward.  

View

Tool Bars Displays list of available Tool bars.

Status Bar Switches display of the Status Bar on or off.

Zoom In Increases the size of the displayed elements.

Zoom Out Decreases the size of the displayed elements.

Expand Expands Data Payloads and Status Fields at the Sequence, FIS, 
Command, and all levels. 

Menu Function
30



SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
4.6  The Toolbar 

The Tool Bar provides quick and convenient access to the 
most used SATracer/Trainer software functions. Tool Tips briefly describe 
the functionality of each icon and menu item as the mouse arrow is moved 
over the icon/item. 

Collapse Collapses Data Payloads and Status Fields at the Sequence, FIS, 
Command, and all levels. 

Hide Hides information from the display window. 

Wrap Wraps displayed sequences within the window.

Window

New Window Switches display of the Tool bar on or off.

Cascade Displays all open windows in an overlapping arrangement.

Tile Horizontal Displays all open windows as a series of strips across the display.

Tile Vertical Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help

Help Topics ... Opens online help.

Update License... Displays a window for updating the software license

Display License 
Information...

Displays information on the current software license. 

About SATracer Displays version information about SATracer/Trainer.

Open file
Hide idle sequences

Save As

Allows complex searches

Preview Find Next - repeats last Find or Go To 
operation

Print… File Information Report

Menu Function
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Note - These buttons  are specific to SATrainer.

4.7  Pop-Up Menus
Clicking the trace with the right or left mouse button displays a pop-up 
menu with options for formatting the display. 

Edit ... Opens Notepad for 
editing traffic generation 
files (.stg). 

Error Report

Setup Record Options Timing and Bus Usage Calculations

Setup Display Options

Show Data - Opens the Data window and 
displays the data for a selected data field in a 
FIS or Command

Start Recording Traffic Summary

Stop Recording Bus Utilization

Re-upload part or all of the 
trace from analyzer to PC.  
Requires that the Enable 
Partial Upload button be 
pushed first.

View Sequence Level

Enable Partial Upload.  
Allows the user to re-upload 
part of the trace.  See page 
121 for details.

View FIS level

Record with/without Syncs 
and Aligns View ATA Command Level

Zoom In Analyzer Only Mode

Zoom Out Connect Trainer sequence

Wrap Disconnect Trainer sequence

Show/Hide ALIGN 
primitives Turn on SSC on the Generator.

Shows/Hides data after 
Cont(XXXX)

Turn off SSC on the Generator

Show Sequence level data 
scrambled or unscrambled Start, stop, resume traffic generation
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Left Mouse Button - If you click a cell in the trace with the left mouse 
button, a pop-up menu appears and displays options for modifying the 
contents or appearance of the selected cell. The menu is context-sensitive 
and varies depending on the selected cell. 

A menu similar to the following appears:

• Data field - Indicates the type of field that you selected. This field 
is context sensitive.

• View Data Block - Allows raw data to be viewed from a data cell. 

• Collapse/Expand Data - Collapses or expands data field. 
Summarizes the amount of data displayed in the cell. 

• Expand All Data Fields On This Level - Expands any data 
fields that are currently collapsed at this level. 

• Collapse All Data Fields On This Level - Collapses any data 
fields that are currently expanded on at this level. 

• Expand All Data Fields On All Levels - Expands any data fields 
that are currently collapsed at all levels.

• Collapse All Data Fields On All Levels - Collapses any data 
fields that are currently expanded at all levels.
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Right Mouse Button - If you click a cell in the trace 
with the right mouse button, a pop-up menu appears and 
shows the options for zooming in or out, wrapping the 
display, and other formatting options.

4.8  Status Bar
The Status Bar is located at the bottom of the main 
display window. Depending on the current activity, the 
bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays 
a recording Progress Indicator:  

As recording progresses, the Progress Indicator changes to reflect the 
recording progress graphically:

• In the Progress Indicator, a black vertical line illustrates the 
location of the Trigger position you selected in Recording Options. 

— Pre-Trigger progress is displayed in the field to the left of the 
Trigger Position in the before-Trigger color specified in the 
Display Options. 

— When the Trigger position is reached, the progress indicator 
wiggles as it waits for the Trigger. 

— After the Trigger occurs, the field to the right of the Trigger 
Position fills in the after-Trigger color specified in the Display 
Options. 

— When recording is complete, the upper half of the progress 
indicator fills in white, indicating the progress of the data 
upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate 
that not all the expected data was recorded pre-Trigger. 
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• When you click Stop before or after a Trigger event, the Progress 
Bar adjusts accordingly to begin uploading the most recently 
recorded data.

• If you wish to abort an upload that is in progress, click the Stop 
button again.

The Progress Bar fills with color in proportion to the specified size and 
actual rate at which the hardware is writing and reading the recording 
memory. However, the progress indicator is normalized to fill the space 
within the Status Bar.

Recording Status
During recording, the current recording status is displayed in the next 
segment. When you activate the Record function, this segment flashes one 
of the following messages (depending on the selected Recording Options):

• Trigger?

• Triggered!

• Uploading

After recording stops, The following occurs:

• Flashing message changes to Uploading data–x% done (x% 
indicates the percentage completion of the data uploading process). 

• Traffic data is copied to disk (overwriting any previous version of 
this file) using the default file name data.sat. You can also create a 
file name of your choice by specifying one in the Recording 
Options window.

To abort the upload process, press the Stop button.

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display 
window, and the Recording Status window is cleared. 

• If the recording resulted from a Trigger event, the first sequence 
following the Trigger (or the sequence that caused the Trigger) is 
initially positioned second from the top of the display.

• If the recording did not result from a Trigger event, the display 
begins with the first sequence in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays 
Recording activity as a series of vertical bars. 
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The more vertical bars that are displayed, the greater the amount of activity 
being recorded.  If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note If traffic is filtered out or if data is truncated, the trace may not 
have the data it needs to  decode Transactions or Commands 
properly.  

Search Status
The rightmost segment displays the current search direction: Fwd (forward) 
or Bwd (backward).  

4.9  Navigation Tools
You can zoom in and out, and wrap Sequences, FISs, and Commands to fit 
within the screen by using the following buttons:

Zoom In
Increases the size of the displayed elements, allowing fewer (but larger) 
sequence fields per screen. 

Click  on the Tool Bar.

Zoom Out
Decreases the size of the displayed elements, allowing more (but smaller) 
sequence fields per screen. 

Click  on the Tool Bar.

Wrap
Adjusts the Trace View so that sequences fit onto the next line if they are 
longer than the size of the window. Without Wrap, you can use the 
horizontal scroll bar to see the hidden part of a sequence.

Click  on the Tool Bar.

4.10  Adding Comments to the Trace
You can create, view, or edit the 100-character comment field associated 
with each Trace file.

Step 1 From the File menu, select Edit Comment.
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The Edit Trace Comment Dialog window appears.

Step 2 Create, view, or edit the comment.

Step 3 Click OK.
 37



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
38



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
5.  Recording Options - UPAS 10K
Note The following chapter describes how to configure Recording 

Options for SATracers based on the UPAS 10000 platform.  If 
you are running an SATracer on a UPAS 2500H platform, see 
chapter six.  

The Recording Options dialog box presents options for configuring a 
recording.  The dialog box has three pages:  General,  Miscellaneous, and 
Recording Rules.  The General page present general types of options that 
affect all recordings.  The Miscellaneous page presents options for 
configuring the traffic speed that will be recorded.  The Recording Rules 
page allows triggers and filters to be set on different events.

Note To configure the analyzer software to display the UPAS 10000 
or the 2500H Recording Options, select Setup > Application 
Preferences ... from the menu and then select or de-select the 
option  If no analyzer is connected, use UPAS 10K recording 
options, then click OK. 

Opening the Recording Options Dialog
To open the Recording Options dialog, select Setup > Recording Options  
from the menu.

Recording Options window appears, displaying the General tab.
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5.1  General Recording Options
The General Recording Options allow you to select or adjust the recording 
type, the buffer size, the amount of post-Trigger recording, and the Trace 
filename and path.

Recording Type
The Recording Type box gives three options that allow you to set how 
SATracer/Trainer begins and ends a recording. The options are Snapshot, 
Manual Trigger, and Event Trigger.

• Snapshot: Fixed-length recording whose size is determined by the 
"Buffer Size" box in the Recording Options dialog or by a manual 
click of the Stop button. Recording begins when the Start 
Recording button   is clicked and ends when either the selected 
buffer size is filled or the Stop Recording button  is pressed. 

• Manual Trigger: Recording whose Trigger point is caused by 
pressing the Trigger button on the front panel.

Recording begins when you click  on the Tool Bar. Recording 
continues in a circular manner within the limits set by the buffer 

size. Recording ends when   is clicked on the Tool Bar or after 
post-Trigger memory has been filled following depression of the 
Trigger button on the front panel.

• Event Trigger: Recording whose Trigger is defined by a specific 
event or events. Recording begins when you click  on the Tool 
Bar. 

Recording continues in a circular manner within the limits set by 
the buffer size until an event is detected that meets the Trigger 
conditions specified in the Triggering Options and the defined 
amount of data has been recorded after the Trigger event.

Options
The options checkboxes appear on the upper right side of the General tab of 
the Recording Options window. 

• Truncate Data Fields:  Allows Data Payload Dwords to be 
truncated during a recording in order to preserve recording 
memory.  The length of the truncated Data Payload Dword is 
specified in the box marked "Dwords."

• Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the SATracer/Trainer beeps three times 
when a Trigger condition is first detected.
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• Save External Interface Signals:  Causes the analyzer to save 
signals from a Break-out board as fields in the trace.

Buffer Size

The Buffer Size box has a slide bar for adjusting 
the recording buffer size from 16 megabytes to 
2 GB. 

The Recording Type option determines how 
this buffer is used. Although there are 2 GB of 
physical memory in the Analyzer, the efficiency of the recording is about 
75% or better. 

You must have an equivalent amount of physical memory on the computer 
controlling the SATracer analyzer. 

Note The scale is not linear and affords more granularity in the smaller 
buffer sizes. 

Trigger Position

The Trigger Position slide bar sets the 
amount of pre- and post-trigger recording. It 
also allows adjustment of the location of the 
trigger within the defined buffer. You can 
adjust the Triggering Position between 1 
and 99% post-Trigger. Trigger Position is 
available only when Manual Trigger or Event Trigger is selected as 
Recording type.

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger

• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 

• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger

• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

When a Trigger occurs, recording continues until the post-Trigger amount 
of the buffer is filled.
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5.2  Miscellaneous
The Miscellaneous page controls speed settings, descrambling, packing and 
other options for each channel.  It also allows recording to be inhibited on a 
per channel basis. 

Link Speed - Set the link speed of the analyzer for the devices that are being 
recorded.  If you do not set the correct link speed, errors will result in the 
trace.  

This release requires the user to designate the recording speed for each link. 
The SATracer system is designed to pass through the speed negotiation 
signaling allowing the initiator and device to determine the link speed using 
the method defined in the SATA specification. However, if the negotiated 
link speed is higher or lower than the speed selected in this tab, SATracer 
will not decode the traffic properly (there will be errors in the trace). If an 
initiator and target are successfully negotiating 3Gbps transmission rate, 
choose the 3Gbps Speed Selection in this tab. The user will know if devices 
are negotiating successfully by getting clean recordings.

OOB Idle Sensitivity - The OOB Idle Sensitivity selection sets the 
sensitivity level for the DUTs.  The OOB spec for SAS and SATA are 
slightly different: the minimum burst amplitude for the OOB period in SAS 
is 240mV whereas in SATA it is 325mV.  

High Swing Voltage - Sets the High Swing voltage. If using SATA devices,  
de-select the option to use low swing voltage.
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Inhibit - Inhibits recording of traffic from selected channels.  For example, 
if you check the option for H, it means "record the device channel only."

No Descrambling - Turns off the analyzer’s descrambling from the selected 
channels.  Select this option if your DUTs are not descrambling their traffic.

No Packing -  Turns off primitive and idle packing from the selected 
channels.  This option is intended for debug use only and should be used if 
so directed by CATC.  

Send Email When Trigger Occurs - If checked, this option will open a 
dialog box prompting the user for an email address.  Upon triggering, the 
user will be sent an email notification of the trigger event.

5.3  Recording Rules
The Recording Rules page is where triggers and filters are set. The page 
divides into following areas:  

• Toolbar - Contains buttons that control the Recording Rules page.  

• Available Events area -- Part of the screen where you can park 
buttons that you intend to use in the Global State Cell.

• Global State Cell -- Part of the screen where you create trigger and 
filter conditions. You create conditions by dragging event buttons 
from the Available Events Area into the Global State Cell and then 
assign actions to the event buttons.  

• Sequence Cell -- The inactive cell marked by the faint text Drag an 
event here to add a new sequence.  Once an event button is placed 
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in this cell, the cell becomes active.  The Sequence Cell is used to 
create event sequences - chains of events leading to an action:  If x 
followed by y followed by z occurs, trigger.  Event Sequences are 
created by assigning the action Advance the Sequence to the links in 
the chain and trigger (or some other action) to the final event.

• Rule Status Button - A button that indicates if the rules the user 
has created are valid or invalid.  When the rules are correct, the 
button will display the text Config is valid.  When incorrect, the 
button will turn red and display the text Config is Invalid.

• Pop Up Menus (not shown) - Right-clicking on button or area in 
the Recording Rules page will access a context-sensitive pop-up 
menu containing most of the commands listed in the toolbar.

5.4  Recording Rules Toolbar
The Recording Rules toolbar exposes functionality for controlling the 
Recording Rules page.  

New Event.  Creates a new event in the Available Events area.  
A set of cascaded menus will pop up.

Delete Event.  Deletes selected event.

Undo.  Undoes last change made to Recording Rules page.  
The undo buffer has unlimited depth.

Redo.  Repeats changes undone by the Undo button.

Zoom In.  Enlarges the display.  There are five zoom levels.  
The default level is the middle one.  If you have a wheel 
mouse, you can also zoom by holding down the Control key 
and then operating the mouse wheel.

Zoom Out.  Makes the display appear smaller.  

Show/Hide channels.  When pressed, this button tells the 
Recording Rules dialog to show the channel buttons on the 
Events icons.  When unpressed, the channels are hidden.  
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5.5  Recording Rules Page - How it Works
The Recording Rules page can be thought of as a chalk board where you  
create a graphical model of the events and actions.  In essence, you are 
creating a visual representation of the rules that the analyzer should follow 
during a recording when it encounters events that you specify.

You can create simple or complex rules.

Creating a rule involves four steps: 

Step 1 Create Event buttons.

Step 2 Select the Host and/or Device channels that the analyzer should 
record by clicking the small buttons marked H and D on each Event 
button.

Step 3 Move the Event buttons to the Global State Cell or to the Sequence 
Cell.

Step 4 Assign an action such as Trigger to the events buttons. 

Show/Hide Properties Dialog.  Shows or hides the Properties 
dialog of the selected State/Event/Action.

Config is valid.  This message displays when the current 
Recording Rules configuration is valid and can be executed by 
the hardware.  This message gets updated every time the 
Recording Rules configuration changes.  When the 
configuration is incorrect, the message is replaced by "Config 
is incorrect."

Config is invalid.  This message displays when the current 
Recording Rules configuration exceeds hardware limitations.  
You can click the button to get the diagnostics message box to 
find the problem.
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Creating Event Buttons 

To create a rule, you start by creating one or 
more Event buttons.  To create a new Event 
button, click the New Event button and then 
select an event from the resulting menu.  A new 
Event button appears and is automatically 
parked in the Available Events area.  The 
following steps show the process.

Step 1 Click the New Event button. 

A menu of Events displays.

Step 2 Select an Event from the menu.  The selected 
Event will appear in the Available Events area.  

Step 3 To move the button to the Global State Cell, hold 
the left mouse button down and drag it. 

Selecting a Channel on an Event Button

At the bottom of each event button are two small buttons 
marked H and D that represent Host and Device channels.  
Selecting a channel button defines which channels should 
be monitored for matching the specific trigger event.  For example, if you 
depress the H button but not the D button it means "Look for the trigger 
event on only the Host channel." 

Please note that deselecting a channel button does not stop the recording on 
that channel - it  merely disables actions such as triggers from occurring.  
Thus, if you had set the analyzer to trigger on any error but had deselected 
channel H, the analyzer would record traffic on both channels but would 
ignore errors on channel H.

To turn off recording for individual channels, use Inhibit Recording in the 
Channel Settings Recording Options page.  This option will prevent traffic 
from being recorded into the trace.  

Dragging a Button to the Global State Cell

To activate an Event button, 
you need to drag the button to 
the Global State Cell or 
Sequence Cell. To activate an Event button, drag it to the 

Global State Cell.
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Global State Cell - The Global State Cell 
tells the analyzer what events to look for 
throughout the entire recording.  The cell is 
called a "Global State" because the 
conditions you define in the cell are always 
active.  You can place several events in this 
cell.  Doing so tells the analyzer to look for 
all of the events.   For example, you could 
place three events in this cell and have each 
cause a trigger.  Such a configuration would 
read "If x, y or z occurs, trigger."

Sequence Cell - The Sequence 
Cell is used to create event 
sequences.  An event sequence 
is a chain of events leading to 
some action.   For example, "If 
x is followed by y and then by z, 
trigger."  There can be up to 255 
events linked together into a 
sequence.

Event sequences are created by assigning the action Advance the sequence 
to events in the chain.  The last event is then assigned the action Trigger.  

Assigning an Action

Once an Event button has been moved to the Sequence Cell or Global State 
Cell, an action such as Trigger can be assigned.  Assigning an action tells 
the analyzer what to do when it has found the targeted event.  If you do not 
assign an action, the analyzer will look for the event but do nothing once the 
event has been encountered.

There are two ways to assign an action to an event button:

• Right-click on an event button and select Specify Action from 
the pop-up menu.

• Double-click on the event button and then select an action from 
the Properties dialog box.

Note If you do not assign an action to an event button, the analyzer will 
ignore the selected event.

This configuration reads
"trigger if any of these events
occur."

An event sequence.  This reads "If a primitive 
is followed by an error, then trigger."
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Assigning an Action from the Pop-up Menu
To assign an action to an event button via the pop-up menu,

Step 1 Right-click on the button.  A pop-up menu appears:  

Step 2 Select Specify Action and then an action from the sub-menu.  The 
menu closes and the action is assigned.  

Assigning an Action via the Properties Dialog Box
Step 1 You can also assign actions to event buttons via the 

Properties dialog box.  Double-click on an event button to 
open the properties dialog box.    
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Step 2 Select the Actions tab.  The Actions page opens.  

Step 3 Assign an action.

See Section 5.8 "Types of Properties Dialog Boxes" on page 52 for 
further details on  Properties dialog boxes.

5.6  Types of Pop-up Menus
The pop-up menu are context-sensitive and will display different options 
depending on the object you have clicked.

Global State Cell Pop-up Menu

If you click on the Global State Cell (but 
not one of the buttons inside it), you will 
get the following pop-up menu: 

New Event - Brings up a menu of Event types.  This is the same menu that 
appears when you click the New Event button on the toolbar.

Properties - Brings up the State Properties dialog for the selected state.

Event Pop-up Menu

If you click on an Event button, you will get the 
following pop-up menu:  

Specify Action(s) - opens a sub-menu with the 
following options:

• Trigger - Triggers end of recording.  
Recording continues until post-trigger buffer 
is expended.  Buffer settings are controlled 
by the Recording Options - General page.
 49



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
• Filter Out - Excludes selected traffic from recording. Filtering 
preserves recording memory, thereby extending recording sessions and 
excluding events of little interest.

• Advance the Sequence - Appears only in Sequence Cells and is used to 
create event sequences.  Tells the analyzer to look for the next event in 
the sequence.  

• Filter In - Includes selected traffic in recording.

• External Trigger Pulse HIGH - Sends an output signal with a Pulse 
High format through the output ports on the back of the UPAS.  Pulse 
High is the default format.  Pulse High causes the analyzer to transmit a 
5 volt, 40 nanosecond signal.

• External Trigger Pulse LOW - Sends an output signal with a Pulse 
Low format through the output ports on the back of the UPAS.  Pulse 
Low causes the analyzer to transmit a 0 volt, 40 nanosecond signal.

• External Trigger Pulse TOGGLE -This format causes the analyzer to 
transmit a signal that will toggle with each trigger event between a 
continuous 5 volt signal and a continuous 0 volt signal.

Add Counter - Displays the Event Properties dialog with the Counter 
selected and ready to accept the count value.  The menu item is not shown 
if the counter is not applicable to the selected event.  If the counter is already 
specified this menu item is replaced with Don’t Use Counter and Change 
Counter Value.

Move Event To - Moves selected event to a different position in the 
Recording Rules window.

Copy Event To - Copies selected event to a different position in the 
Recording Rules window.

Delete this Event - Deletes the selected Event.  Alternatively, you can use 
the Delete button on the toolbar or keyboard to delete events.

Properties - Opens a dialog box and lets you specify further sub-types (for 
example, types of errors) and additional conditions for the selected event. 

Action Pop-up Menu

If you click on an Action button, you will get 
a pop-up menu with most or all of the 
following choices:  

Trigger - Sets or clears Trigger action.

Filter In - Sets or clears Filter In action.  This 
option precludes the use of Filter Out.
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Filter Out - Sets or clears the Filter Out action.  This option precludes the 
use of Filter In.

Restart All - Restarts any sequences 
or counts you may have set on other 
buttons.  The example on the right 
illustrates how the Restart All action 
works.  This example reads "Look 
for a sequence of five Primitives and 
then trigger.  If, however, an Error 
occurs any time before the fifth 
Primitive has occurred, restart the 
count." 

External Trigger Pulse HIGH, 
Pulse LOW, Pulse TOGGLE - 
Causes the event send an external 
signal out through the External Out 
port on the back of the UPAS.  The 
shape of the signal (Pulse HIGH, 
Pulse LOW or Pulse TOGGLE) must 
be the same for all events sending out 
such signal.  This means that if you 
change the output signal for one 
event, it will automatically change the signal for all other events sending 
output signals.

Properties - Displays the Action Properties dialog for the selected state.

5.7  New Events Menu 
To add new Event buttons to the 
Available Events area, click the New 
Events button.  A menu opens with the 
following categories:

• Primitives
• FIS Types
• Commands
• Data Pattern
• Bus Conditions and OOB Signals
• Errors
• Breakout Board Data
• Timer

Restart example.  In this configuration, 
SATracer will restart its search for a 
sequence of 5 primitives if an error is
encountered.

Second restart example.  In this 
configuration, SATracer will restart
its search for the above sequence of
events if a Primitive is found.
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5.8  Types of Properties Dialog Boxes
Each cell and button has a properties dialog box that allows refinement of 
the options being set.  Properties dialog boxes can be opened by: 

• Double-clicking a button or cell.

• Right-clicking a button and selecting Properties from the pop-up menu.

• Clicking the Properties button on the toolbar. 

Properties dialog boxes exist for all items in the Recording Rules page:  the 
event buttons, action buttons, Global State cell and Sequence cells.

Properties Dialog Box - General Features

Properties Dialog boxes share several features:  an Icon preview, a Label 
Icon, Channel Settings, Negation, Counter, a Pin button, and a Descriptive 
String.     

Icon Preview - The Icon Preview shows you what the button looks like.  If 
you make changes to the Channel settings or the Icon Label, these changes 
will immediately display in the Preview.

Icon Label - A text box for labeling the button.  Whatever you type here will 
appear on the button.

Channels - These controls allow you to select the channel(s) that the 
analyzer should search when it is looking for the event.  

Counter - A counter tells the analyzer to search for x instances of the 
selected event.  For example, if "10" is entered, the analyzer will count 10 
instances of the selected event before it performs whatever action has been 
assigned.  There are only two counts available in the hardware so if you try 
to assign more than two, you will get a warning. 

Note Counters can not be applied to events with Filter Actions.  The 
maximum counter value is 65,535. 
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Negation - Tells the hardware to match the opposite of the event.  For 
example, if you select NOT for Errors Event, the match will occur on Error 
types that are not checked.  

Pin Button - Allows you to "pin" the Properties dialog box to the 
application so that it stays on screen when other objects appear.

Description String - This area contains a textual description of the event.

Specific Event Settings - The largest part of the Event Properties dialog 
box.  By selecting one or more events from the list, you narrow the range of 
events that the analyzer searches for.  

The options presented in this area vary depending on the selected event.  
There are three basic formats:

• Checkboxes 

• List

• Pattern Editor

Checkboxes and Lists present options for you to select from.  Selecting one 
or more option tells the analyzer which event(s) the analyzer should search 
for.  Examples are shown below:   
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The Pattern Editor, on the other hand, presents a series of text boxes in 
which you can enter a data pattern that the analyzer should seek.  Pattern 
Editors can be seen in any of the FIS Type properties dialogs and in the Data 
Pattern properties dialog.

The Pattern Editor has two components:  the text boxes themselves, in 
which a binary pattern can be entered, and blue field headings.  The blue 
field headings can be clicked to open either a decimal editor that will 
convert your decimal value into binary or a pull-down menu like the FIS 
Types menu shown below.  

Properties Dialog - Actions Page - The Actions tab opens a page of options 
for setting  triggers and other actions on the selected events.    
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5.9  Event Properties Dialog Boxes - Descriptions
Each event button has a Properties dialog box opens with options for further 
specifying the type of event that the analyzer should look for.  Selecting an 
option narrows the search pattern to the selected event.

To open a Properties dialog box for an event button, double click it.

Properties dialog boxes have two pages of options:  one listing event 
sub-categories, and the other listing actions. Below is an example.  
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There are properties dialog boxes for each of the event categories listed in 
the New Events menu.  Each dialog is described in this section. 

PRIMITIVES

The various types of Primitives are collectively listed in the Primitives 
properties dialog.  Selecting a Primitive from the list narrows the analyzer’s 
search to just the selected Primitive.  Afterwards, a trigger or filter can then 
be set on the selection.  If NOT is checked, any unchecked primitive 
category will generate an event match. 

Category Event

Primitives

FIS Types Register H to D

Register D to H

DMA Activate

DMA Setup

BIST Activate

PIO Setup

Data FIS

Set Device Bit

Route

Vend FIS: 0xFF

Commands See Commands section below.

Data Patterns

Bus Conditions and OOB Signals

Errors

Breakout Board Data

Timer
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FIS TYPES
The FIS Types properties dialog presents options for triggering or filtering 
on several different FIS categories.  An example (Register Device to Host) 
is show below.  Each FIS Properties dialog box displays a pattern editor that 
allows you to set a bit pattern to be matched.  If NOT is checked, any 
unchecked primitive category will generate an event match. 

Note that some of the data fields have drop-down menus.  To see which 
fields have menus, position your mouse pointer over the blue field headings.  
If the pointer changes into a hand, then the heading will present a menu if it 
is clicked.   

COMMANDS
The Commands Properties dialog box contains a long menu of commands 
and presents additional options that vary depending on which command has 
been selected.
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Example of Commands Properties Dialog Box
Each of the Commands properties dialog boxes is organized similarly to the 
example shown below.  

Command - Presents a menu of all of the Commands listed in the New 
Events menu.

Sort commands by name - Organizes the Command menu alphabetically 
by name.

Sort commands by code - Organizes the Command menu by code.

Features: - Features refers to the contents of the Features register.  To 
trigger on Features, enter a value in the box.  This option is context-sensitive 
and is not available for all Commands.

Sector Count - Sector Count refers to the contents of the Sector Count 
register.  To trigger on Sector Count, enter a value in the box.  This option 
is context-sensitive and is not available for all Commands.

LBA Mode - Select this option to activate LBA (Logical Block Address) 
addressing.  Then enter an address into the text box.  The term LBA defines 
the addressing of data on the device by the linear mapping of sectors.

Sector/Cylinder/Dev/Head Mode - Select this option to activate the 
following parameters:

Sector Number - Enter a value to trigger on the Sector Number register.

Head Number - Enter a value to trigger on the Head Number register.

Cylinder Low - Enter a value to trigger on the Cylinder Low register.

Cylinder High - Enter a value to trigger on t he Cylinder High register.
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Sector Number - Sector Count refers to the contents of the Sector Count 
register.  To trigger on Sector Count, enter a value in the box.  This option 
is context-sensitive and is not available for all Commands.

Commands
The following commands are listed in the Commands properties dialog:

• Execute Device Diag
• Device Reset
• CFA Erase Sectors
• CFA Request Ext Error Code
• Check Power Mode
• Flush Cache
• Flush Cache Ext
• Get Media Status
• Idle
• Idle Immediate
• Initialize Device Params
• Media Eject
• Media Lock
• Media Unlock
• Nop
• Read Native Max address
• Read Native Max address Ext
• Read Verify Sectors
• Security Erase Prepare
• Security Freeze Lock
• Seek
• Set Features
• Set Max Address
• Set Max Address Ext
• Set Multiple Mode
• Sleep
• Smart
• Standby
• Standby Immediate
• CFA Translate Sector
• Identify Device
• Identify Packet Device
• Read Buffer
• Read Multiple
• Read Multiple Ext
• Read Sectors
• Read Sectors Ext
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• CFA Write Multiple wout Erase
• CFA Write Sectors Wout Erase
• Download Microcode
• Security Disable Password
• Security Erase Unit
• Security Set Password
• Security Unlock
• Write Buffer
• Write Multiple
• Write Multiple Ext
• Write Sectors
• Write Sectors Ext
• Read DMA
• Read DMA Ext
• Write DMA
• Write DMA Ext
• Packet 
• Service
• Read DMA Queued
• Read DMA Queued Ext
• Write DMA Queued
• Write DMA Queued Ext
• Read Stream SMA
• Read Stream PIO
• Read Log Ext
• Write Stream DMA
• Write Stream PIO
• Write Log Ext
• Read Verify Sectors Ext
• Configure Stream
• Device Configuration
• Check Media Card Type
• Smart Read Data
• Smart Read Log
• Smart Write Log
• Smart Enable Operations
• Smart Disable Operations
• Smart Return Status
• Smart Execute Off Line
• Smart Enable Disable Autosave
• Smart Save Attribute
• Device Config Freeze Lock
• Device Config Identify
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• Device Config Restore
• Device Config Set
• Read SFO
• Write SFO
• SEP ATTN
• Read FPDMA Queued
• Write FPDMA Queued
• Recalibrate
• Format Track
• Identify Device DMA
• Read DMA Without Retries
• Write DMA Without Retries
• Read Sectors Without Retries
• Write Sectors Without Retries
• Read Long
• Read Long Without Retries
• Write Long
• Write Long Without Retries
• Write Verify
• Write Verify Without Retries
• Read Verify Without Retries

DATA PATTERN

The Data Pattern properties dialog allows you to set triggers or filters on a 
user-defined bit pattern. 
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BUS CONDITIONS AND OOB SIGNALS

This properties dialog presents options for triggering or filtering on Bus 
Conditions and OOB Signals.  To specify a bus condition or OOB signal, 
check the appropriate option.   If NOT is checked, any unchecked primitive 
will generate an event match. 

ERRORS

The Errors properties dialog presents options for triggering or filtering on 
Error types.  To specify an error type, check the appropriate option.   If NOT 
is checked, any unchecked primitive will generate an event match.
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BREAKOUT BOARD DATA
The Breakout Board Data properties dialog box lets you specify a bit 
pattern from a breakout board that can be used for triggering.  If NOT is 
checked, an event match will be created for any pattern other than the one 
specified. 

TIMER

The Timer properties dialog allows delays to be added to sequences.  
Timers let you create statements such as "Look for an error. When the error 
occurs, wait three seconds and then trigger."

Timers values are seconds, milliseconds, microseconds, and nanoseconds.  
The set timer value appears at the bottom left corner of the dialog and 
reflects the hardware precision capabilities.  The time is rounded up to the 
next 7.519 nanosecond sample, which corresponds to the 1.33 MHz internal 
clock frequency.  
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5.10  State Properties Dialog
Both the Global State and Sequence Cells have their own properties dialog 
boxes.  Double-click on either of these cells (but not on an event button 
within them), to open the State Properties dialog.  

The State properties dialog allows the caption.   

5.11  Assigning Actions
Actions can be assigned to buttons two ways:  by right-clicking an event 
button and selecting an action from the pop-up menu; and by double-click a 
button to open the Properties dialog box, and then select the Actions tab.  
You can then select an action from one of the options.

The assigned action will be represented by a button to 
the right of the Event button.
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The following table shows the types of Actions you can select. 

5.12  Setting Conditions:  The Role of the Global State 
Cell 

The Global State cell is the place for 
creating triggering and/or filtering 
conditions that are active at all times. 
You can think of these conditions as 
the default conditions.  You use the 
Global State cell to create simple condition such as "Trigger when you see 
an xxx error," or "filter out all xyz primitives."

Action Comment 

TRIGGER 

Triggers the end of the recording.  
The end point of the recording is 
determined by the buffer settings in 
the Recording Options General 
page. 

FILTER OUT 

FILTER IN 

Filters traffic in or out of the 
recording - thereby conserving 
recording buffer space. 

Can not be assigned to the events 
with Counters.  

RESTART ALL Reinitializes counters.  
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Example - Creating a Simple Event Trigger
To create a simple condition that is active at all times, place an event button 
in the Global State cell:

Step 1 Click the New Event button.  An Events 
menu opens (shown right).  

Step 2 Select an event from the menu.  The 
event will appear as a button in the 
Available Events area on the left.

Step 3 Drag the event button to the cell marked 
"Global State."

Step 4 Right-click on the button (i.e., not the 
Global State cell).  A pop-up menu 
appears.

Step 5 Select Trigger from the menu.  An arrow will project from the error 
button and point to a cell marked Trigger.

Creating Multiple Event Conditions in the Global State Cell
When multiple buttons are placed in the Global Cell, it creates an "AND" 
condition or an "OR" condition depending on the actions selected.  

Creating an OR Condition - When two or more buttons in the Global State 
cell are assigned the same action, the analyzer will search for all of the 
events and perform the action on which ever event it sees first.  The example 
below illustrates.  It reads "Trigger if an error or a primitive occurs".  
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Creating an AND Condition - When multiple events are placed in the 
Global State cell and assigned different actions, an AND statement is 
created.  The example below reads "Trigger if an error occurs AND filter out 
any primitives that occur." 

Filter In and Filter Out
A filter causes the analyzer to filter in or out specified events from the 
recording. If events are filtered out of the recording, they are excluded and 
not simply hidden from the trace. The purpose of filtering is to preserve 
recording memory so you can conduct longer recording sessions and 
exclude events that do not interest you.

To Filter In or Out traffic,

Step 1 Click the New Event button.  The New Event menu opens.

Step 2 Select an event from the menu.

Step 3 Drag the event into the Global State cell.

Step 4 Right-click on the button.  A pop-up menu opens.

Step 5 Select Specify Action(s)

Step 6 Select Filter Out (for example).

The analyzer is now configured to filter out the selected event. 

Filter In and Filter Out

The options Filter Out Everything or Filter In Everything allow you to 
filter all traffic in or out of the trace.  These options are intended for a future 
release to allow you to selectively exclude and include traffic from a 
recording.  
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Counting Events
In addition to setting triggers and filters, you can also set counters.  A 
counter is an action that allows you to set a trigger based on a count of 
events. For example, you could use a counter to "Trigger following the 16th 
occurrence of an error."

To use a counter, follow these steps:

Step 1 Select an event from the Select Event menu and drag it to the Global 
State Cell in the center of the dialog box.

Step 2 Click the small channel buttons on the selected Event button to 
select the channels for the actions.

Step 3 Double click on the event.  The Properties dialog box opens for the 
selected event.

  

Step 4 Check the box marked Count. 

Step 5 In the text box to the right of the label Count enter a value. 

Step 6 Click the X in the top right corner of the dialog box to close the 
dialog. A counter button should appear below your selected event.
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5.13  Creating Event Sequences
Event sequences are chains of events leading to some action. A sequence is 

a multi-event "if, then" condition:  "If x followed by y followed by z occurs, 
trigger."  Event sequences are created by dragging two or more buttons into 
the Sequence cell.  The Sequence cell is a faintly marked cell just below the 
Global State cell.  The Sequence cell contains the text Drag an event here 
to add a new sequence.  

Note Event sequences can only be created in the Sequence cell.  You 
cannot create a sequence in the Global State cell. 

States
Sequences are made up of cells called States.  A state is a stage within a 
sequence that specifies what events the analyzer should look for and what 
actions to apply when the event occurs.
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In the example below, the Sequence is composed of two states - Sequence 
1, State and Sequence 1, State 2.  The maximum number of states a sequence 
can support is 255. 

The foregoing example reads:  "Trigger if you see a Primitive followed by 
an error."  

How to Create an Event Sequence

To create an event sequence, you drag event buttons to the Sequence cell,  
link them with the action Advance the Sequence, then apply a trigger or 
other action to the end of the chain.  The following steps illustrate how to 
create an event sequence.

Step 1 Click the New Event button.  The New Event menu opens.

Step 2 Select an event type from the menu, for example an error.  A button 
appears in the Available Events area.

Step 3 Click the New Event button and select a second event type, for 
example a Primitive.  At this point, you should see two buttons in the 
Available Events area.  

Step 4 Drag the first button to the cell marked "Drag an event here to create 
a sequence."  When you finish, notice how two new cells appear in 
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the window as shown below the cell where you placed your button. 

Step 5 Double-click on the button.  A Properties dialog box opens.  

Step 6 Select desired options from the dialog box, for example an error 
sub-type.  The options apply immediately.  

Step 7 Close the Properties dialog box by clicking the X in the top right 
corner.  The Properties dialog box closes.

Step 8 Drag the second event button to the cell immediately below the cell 
occupied by your first event button.  Note that an additional cell 
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appears marked "Drag an event here to add a sequence."

Step 9 Right-click on the first event button.  A pop-up menu appears.  

Note Be sure to click on the button itself and not the cell.  If you click the 
cell, you will get a different menu with fewer options.

Step 10 Select Specify Actions.  Notice 
how this menu differs slightly 
from the menu shown earlier in 
this chapter.  You will see three 
options for advancing or 
restarting a sequence:

• Advance the Sequence - 
Draws an arrow that 
connects the selected event button to the event button below it.  
This option creates a sequence.

• Restart the Sequence - (Not visible in the menu above.)  This 
option restarts the entire sequence.  This option appears once you 
have linked two or more buttons in a sequence.  This option  
draws an arrow upward from the selected event button to the 
beginning of the sequence.  

• Restart All - Restart all sequences and counts.  This option 
creates an arrow pointing a cell marked "Restart All."   

Step 11 Select Advance the Sequence.  An arrow will appear that connects 
the first button to the second.

Step 12 Right-click the second button and select Specify Actions.  A 
sub-menu appears.

Step 13 Select Trigger.  A cell will appear to the right of the second button 
saying "Trigger."  Your sequence configuration is now complete and 
72



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
should look like this:

Using a Timer

Timers let you set a time-delay for a trigger or other action. The following 
example illustrates how timers work. 

This example reads "Look for a Primitive.  When you see one, wait three 
seconds then trigger."

To create the example shown above, perform the following steps:

Step 1 Click the New Event button to open the Event menu.

Step 2 Select an event such as Primitive from the menu. An event button 
appears in the Available Events area.

Step 3 Drag the event button into a Sequence cell marked "Drag an event 
here to add another state."  Once the button is added, the cell turns 
blue and acquires a title like "Sequence 1, State 1."  Below the cell, 
a new cell appears  marked "Drag an event here to add another 
state."

Step 4 Click the New Events button.  The Events menu opens.

Step 5 Select Timer.  A Timer button appears in the Available Events list.

Step 6 Drag the Timer Button to the cell marked "Drag an event here to add 
another state."   The cell turns blue and acquires a title like 
"Sequence 1, State 2."
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Step 7 To link the two events into a sequence, right-click on the first event 
(in our example, the Primitive event button).  Be sure to click on the 
event button and not on the cell.  A pop-up menu appears.

Step 8 Select Specify Action(s).  A sub-menu opens.

Step 9 Select Advance the Sequence.  The menu closes and an arrow 
appears that connects this cell to the State cell below.

Step 10 Right-click on the Timer button.  A pop-up menu appears.

Step 11 Select Specify Action(s).  A sub-menu opens.

Step 12 Select Trigger.  The menu closes and an arrow appears that 
connects the Timer button to a new cell to the right marked Trigger.

Step 13 To set the duration of the Timer, double-click on the Timer button.  
A dialog box appears. 

Step 14 Enter a time value in the boxes.

Step 15 Click the x to close the dialog box.  The timer is now set.
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6.  Recording Options - UPAS 2500H
The following chapter describes how to configure Recording Options for 
SATracer based on the UPAS 2500H platform.  These options will appear 
automatically if a UPAS 2500H is attached to your PC.  If you are not 
running an UPAS 2500H, you can configure the analyzer software to 
display the UPAS 2500H Recording Options by selecting Setup > 
Application Preferences ... from the menu and then de-selecting the option   
If no analyzer is connected, use UPAS 10K recording options, then click 
OK.  When you open the Recording Options dialog, it should look like the 
one below.

From the Setup menu, select Recording Options.

Recording Options window appears, displaying the General tab.
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6.1  General Recording Options
The General Recording Options allow you to select or adjust the recording 
type, the buffer size, the amount of post-Trigger recording, and the Trace 
filename and path.

Recording Type
The Recording Type box gives three options that allow you to set how 
SATracer/Trainer begins and ends a recording. The options are Snapshot, 
Manual Trigger, and Event Trigger.

• Snapshot: Fixed-length recording whose size is determined by the 
"Buffer Size" box in the Recording Options dialog or by a manual 
click of the Stop button. Recording begins when  is clicked and 
ends when either the selected buffer size is filled or the   button 
is pressed. 

• Manual Trigger: Recording whose Trigger point is caused by 
pressing the Trigger button on the front panel.

Recording begins when you click  on the Tool Bar. Recording 
continues in a circular manner within the limits set by the buffer 

size. Recording ends when   is clicked on the Tool Bar or after 
post-Trigger memory has been filled following depression of the 
Trigger button on the front panel.

• Event Trigger: Recording whose Trigger is defined by a specific 
event or events. Recording begins when you click  on the Tool 
Bar. 

Recording continues in a circular manner within the limits set by 
the buffer size until an event is detected that meets the Trigger 
conditions specified in the Triggering Options and the defined 
amount of data has been recorded after the Trigger event.

Options
The options checkboxes appear on the upper right side of the General tab of 
the Recording Options window. 

• Truncate Data Fields: Allows data fields to be truncated between 
10 and 251 dwords during the recording in order to save Analyzer 
memory and allow recording of more packets. Enter a minimum 
data length value in the box marked Dwords. SATracer truncates 
the data to the stated value or slightly larger.
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• Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the SATracer/Trainer beeps three times 
when a Trigger condition is first detected.

• Save External Interface Signals: Allows external input signals 
from a breakout board to be recorded.

Buffer Size

The Buffer Size box has a slide bar for 
adjusting the recording buffer size from 0.4 
megabytes to 512 MB. 

The Recording Type option determines how 
this buffer is used. Although there are 512 
MB of physical memory in the Analyzer, the 
efficiency of the recording ranges from 2:1 to 4:1 ratios of physical memory 
to actual Serial ATA traffic. Shorter Serial ATA sequences yield a less 
efficient recording. 

You must have an equivalent amount of physical memory on the computer 
controlling the SATracer analyzer. 

Note The scale is not linear and affords more granularity in the smaller 
buffer sizes. 

Trigger Position

The Trigger Position slide bar sets the 
amount of pre- and post-trigger recording. It 
also allows adjustment of the location of the 
trigger within the defined buffer. You can 
adjust the Triggering Position between 1 
and 99% post-Trigger. Trigger Position is 
available only when Manual Trigger or 
Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger

• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 

• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger

• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger
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When a Trigger occurs, recording continues until the post-Trigger amount 
of the buffer is filled.

6.2  Advanced Options

• Save XXXX: SATracer's Advanced Recording Options includes 
the ability to save and display unformatted XXXX data (both in 
10-bit or in hex format). The ability to save all traffic on the line 
including "idle" or "filler" data is often useful in early silicon 
validation. 

Note this option will rapidly fill SATracer's recording memory and 
can not be used with filtering. 

A significant portion of the constant transmission of Serial ATA  
flow control primitives will contain Idle Sequences. This "filler" 
data is represented by XXXX signals in the CATC Trace display. 
By default, SATracer does not record the actual XXXX traffic but 
discards this information to preserve recording memory. The 
CATC Trace substitutes a place holder for each of the XXXX 
values. 
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• Send Email When Trigger Occurs: Sends email via the host PC. 
The PC must have a fully qualified email address. 

• Use Vendor FISs: Prevents SATracer hardware from reporting FIS 
type errors on vendor-specific FISs. When selected, opens a pattern 
editor that lets you enter data patterns in binary or hex for up to five 
Vendor FISs. After a pattern has been entered, the Define button 
will become active. The Define button lets you edit your FIS data 
patterns.

• Disable HW scramble: 

•HOST: Allows you to disable the BusEngine host side 
descrambler module, so that the host can send unscrambled 
data. This option is useful for viewing traffic from early silicon 
designs that have not yet implemented the scrambling of Serial 
ATA data payloads or primitives.

•DEVICE: Allows you to disable the BusEngine device side 
descrambler module, so the device can send unscrambled data.

Options Name
Descriptive label of the current Recording Options settings. Options names 
are associated with files that have a .rec suffix. 

The default option name is default. Default preserves the current recording 
options settings.

The purpose of the Options Name box is to give you a place to preserve 
different recording options that you use on a recurrent basis. For example, 
if you use two or three different recording options configurations, you can 
save these configurations and load them the next time they are needed.

Because options names are descriptive labels and not file names, you can 
enter in any text you desire into the box.  

To create a new Recording Options name, follow these steps:

Step 1 Enter a comment for the new file in the Options name field.

Step 2 Click Save...

Step 3 Specify a filename (*.rec).

Step 4 Click Save.

To load a Recording Options name, follow these steps:

Step 1 Click Load ...

Step 2 From the list of .rec files, select the one that represents your 
options name.
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6.3  Events Recording Options
Click the Events tab on the Recording Options screen.

The event Triggering and Filtering options allow you to set specific 
parameters for each event group. When an event group is selected, a field 
appears that allows you to select specific conditions within the 
corresponding event group. As details are selected, other event group details 
may fade since there are limited hardware resources in the Analyzer. 
Information about the resources available is displayed below the event 
group details. When a detail is faded, it is inactive and cannot be selected. If 
an event group remains inactive, the current version of the application or 
BusEngine does not support it.
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Primitive Identifiers
Select Primitive Identifiers.

Four pairs of menus display labeled "Primitive" and "Direction."  You can 
select a Primitive from each menu.  The Direction menus lets you optionally 
specify a direction for each selected Primitive.  Your choices are: Host to 
Device, Device to Host, or Both. You can also leave the Direction 
unselected (which is the default condition).  
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The following chart shows the Primitives that appear in the Primitives 
menus and the actions that can be performed on them.  (See Section 6.5, 
“Connecting Events to Actions” on page 105 for details on setting Actions.)  
As can be seen in the following chart, Primitives are not available for Filter 
In operations. 

Note As can be seen in the above chart, the Primitives X_RDY, 
R_RDY, SOF, PMREQ_S, PMREQ_P, EOF, CONT, RTX, 
H_RDY can not be filtered in or out. 

Primitive Trigger Filter Out Filter In Restart

Sync X X X

X_RDY X X

WTRM X X X

R_RDY X X

R_IP X X X

R_OK X X X

R_ERR X X X

SOF X X

HOLD X X X

HOLDA X X X

DMAT X X X

PMREQ_P X X

PMREQ_S X X

PMACK X X X

PMNAK X X X

EOF X X

ALIGN X X X

CONT X X

RTX X X

H_RDY X X

B_OFF X X X

R_NAK X X X

Figure 3:  Actions that SATracer can perform on Primitives.
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Bus Conditions
Select Bus Conditions.

You can select up to six combinations of bus conditions in the checkboxes 
for triggering or filtering.

Note You can not filter in or out Bus Conditions.
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Frame Information Structure (FIS)
Select FISs.

A FIS is the user payload of a frame, exclusive of the SOF, CRC, and EOF 
delimiters. The four sets of drop-down menu presents FIS and direction 
options. Specify any combination of options. 

Note The selections you make here will impact on the number of 
Vendor FISs you can select.  You can select a combined total of 
four FISs and Vendor FISs.  If, for example, you select four 
FISs, then you will not be able to select any Vendor FISs.

Any Action can be set upon the selected FISs (Trigger, Filter In, Filter Out, 
or Restart). 

The FISs presented are:

• Register-H->D  (Host to Device)
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• Register-D->H  (Device to Host)

• DMA Activate

• DMA Setup

• BIST Activate

• PIO Setup

• Data

• Set Device Bit 

Errors
Select Errors.

Specify any combination of errors for triggering.  When you select multiple 
errors, only one Error button will appear in the Actions window.

Note You can not filter in or out Errors from the recording.
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Data Pattern
Select Data Pattern.

In the box labeled Sequence Pattern # 1, enter a Data Pattern with a length 
of up to 16 bytes for triggering. This will cause the analyzer to trigger on the 
pattern anywhere within the payload. 

To specify a second data pattern, enter text into the box labeled Sequence 
Pattern # 2.

Edit Pattern - Allows the analyzer to trigger on a pattern within a specific 
dword. Click Edit Pattern to open a pattern editor that will allow you to 
enter the data pattern on a bit-by-bit basis and thereby keep track of the bits 
and bytes.

Dword Offset - This option lets you specify how many dwords should be 
offset (i.e. skipped) before pattern matching should begin. For example, "1" 
means "begin pattern matching on the second dword." Enter a value in 
hexadecimal.
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To enter data bit-by-bit, follow the next procedure. 

Step 1 Press the Edit button.

The Data Editor window appears.

Step 2 Click on the bits within each byte that you wish to edit, and 
make the appropriate changes. Alternatively, you can also 
enter hexadecimal values into the Mask and Match boxes. 

Step 3 Click OK to close the dialog box.

SATracer can trigger on a data pattern match. There are two modes for this:

• Normal data pattern

• Data pattern with offset

Data pattern is always padded to WORD size (16 bits). For example, "123" 
will be padded to "0123," and "1" will be padded to "0001." The data pattern 
will always be searched as WORD aligned. 

When triggering on a data pattern without the offset, the Serial ATA traffic 
is searched, and a trigger occurs when the data is found. The search 
resolution is (16-bit) WORD size. The search will look for the pattern as 
displayed in the sequence level. 

Data pattern trigger with offset works with resolution of DWORDS. You 
need to enter the values and the offset in the exact position in order to 
trigger. For example, entering "1234" is actually "12340000," which is not 
the same as "00001234."

You can use the "X" to indicate "don't-care" in the value. For example, the 
data pattern "XXXX1234" is different if you use it with or without offset. If 
used without offset, then this is exactly the same as "1234." If used with 
offset, then this means that you wish to trigger on a DWORD where its 
lower WORD is "1234" and the upper DWORD is not defined.
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When editing a Data pattern with the Edit Pattern button, you can edit every 
bit. You can edit the mask and match values, using either binary pattern or 
hexadecimal representation of the values you want. When setting the 
MASK value to 0xF(1111), a full match is required. When setting the 
MASK to 0x0(0000) it means that you do not need any match to trigger.

Note You can not Filter In or Filter Out Data patterns from the 
recording.  Trigger and Restart are the only available Actions 
that can  be performed.

Vendor FISs
Select Vendor FISs.  

If you have not selected any FISs from the FIS options (described on 
page 84), you will be able to select up to four Vendor FISs.  If you have 
selected FISs from the FIS options, a corresponding number of Vendor FIS 
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menus will be greyed out.  For example, if you have selected two FISs from 
the FIS options, then two of the Vendor FIS menus will be greyed out.  You 
can select no more than a combined total of four FISs and Vendor FISs.  

Any action can be performed on the selected Vendor FISs (Trigger, Filter 
In, Filter Out, or Restart).

To specify a FIS, enter the bit values in the boxes marked with Xs or enter 
hex values in the Mask and Match boxes. Use the Direction drop-down 
menu to supply a direction.

External Input Signals
The analyzer can be configured to trigger on external input signals from a 
device such as an oscilloscope.

To trigger from an external source, you will need to connect the triggering 
device to the analyzer using a BNC or RS-232 cable.

Using a BNC Cable

If using a BNC cable, connect the triggering device to one end of the cable 
and the other end to the connector marked "Ext. In" on the back of the 
analyzer. You will not need to terminate the analyzer’s input connector 
because all analyzer inputs are terminated with 50 ohms.

Using an RS-232 25 pin Cable

If using an RS-232 cable, you will also need to use a CATC breakout board 
and alligator cables. Connect alligator cables from the triggering device to 
one or more Data pins on a breakout board. Then connect a 25 pin RS-232 
cable from the breakout board to the 25 pin connector on the back of the 
analyzer marked "DATA IN/OUT."

Once the analyzer is connected, you will need to configure the analyzer to 
trigger on external input signals.
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Setting Recording Options
In the Events window of Recording Options, select External Input Signals.

This option allows the analyzer to trigger on external input signals from an 
external device via a breakout board (for details on the breakout board, see 
Section 3.4, “External Interface Breakout Board” on page 13). To specify an 
External Input Signal, enter bit values in the boxes on the left marked with 
Xs or enter hex values in the Mask and Match boxes. 

Note: If you want the external input signals to be recorded as fields in the 
trace, you must select the option Save External Input Signals under 
Recording Options > General.

Once the Recording Options have been set, the analyzer will be ready to 
record. Start the recording. The analyzer will then trigger when the external 
device generates a triggering signal. 
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FIS Pattern
Select FIS Pattern.

The FIS Pattern option lets you create triggers based on FIS type, direction, 
and patterns. 

To specify a FIS type, make a selection from the pull-down menu labeled 
Type. Depending on the option you have selected, the Direction menu may 
become active and allow you to choose a direction.

To specify a FIS pattern, 

Step 1 Select a FIS type from the pull-down menu. The Edit button 
becomes active.

Step 2 Click the Edit button. A Pattern editor opens that will look like the 
one shown below. Depending on the FIS type selected, the editor 
may look a little different than that shown below. 

Step 3 To specify a pattern, enter a bit value in one or more of the boxes. 
"X" represents a "Don’t Care" value. As an alternative, values can 
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be added in hex in the box on the right. 
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Short FIS Pattern
Short FIS allows the Data Pattern trigger and the FIS Pattern trigger to be 
active simultaneously. Specify a FIS pattern and direction for triggering. 
This FIS is shared with Data Pattern # 1 and Data Pattern # 2 in the Data 
Pattern dialog. 
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Command Level
Select Command Level.

Select from the drop down menu one of the following options:

• Execute Device Diag
• Device Reset
• CFA Erase Sectors
• CFA Request Ext Error Code
• Check Power Mode
• Flush Cache
• Flush Cache Ext
• Get Media Status
• Idle
• Idle Immediate
• Initialize Device Params
• Media Eject
• Media Lock
• Media Unlock
• Nop
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• Read Native Max address
• Read Native Max address Ext
• Read Verify Sectors
• Security Erase Prepare
• Security Freeze Lock
• Seek
• Set Features
• Set Max Address
• Set Max Address Ext
• Set Multiple Mode
• Sleep
• Smart
• Standby
• Standby Immediate
• CFA Translate Sector
• Identify Device
• Identify Packet Device
• Read Buffer
• Read Multiple
• Read Multiple Ext
• Read Sectors
• Read Sectors Ext
• CFA Write Multiple wout Erase
• CFA Write Sectors Wout Erase
• Download Microcode
• Security Disable Password
• Security Erase Unit
• Security Set Password
• Security Unlock
• Write Buffer
• Write Multiple
• Write Multiple Ext
• Write Sectors
• Write Sectors Ext
• Read DMA
• Read DMA Ext
• Write DMA
• Write DMA Ext
• Packet 
• Service
• Read DMA Queued
• Read DMA Queued Ext
• Write DMA Queued
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• Write DMA Queued Ext
• Read Stream SMA
• Read Stream PIO
• Read Log Ext
• Write Stream DMA
• Write Stream PIO
• Write Log Ext
• Read Verify Sectors Ext
• Configure Stream
• Device Configuration
• Check Media Card Type
• Smart Read Data
• Smart Read Log
• Smart Write Log
• Smart Enable Operations
• Smart Disable Operations
• Smart Return Status
• Smart Execute Off Line
• Smart Enable Disable Autosave
• Smart Save Attribute
• Device Config Freeze Lock
• Device Config Identify
• Device Config Restore
• Device Config Set
• Read SFO
• Write SFO
• SEP ATTN
• Read FPDMA Queued
• Write FPDMA Queued
• Recalibrate
• Format Track
• Identify Device DMA
• Read DMA Without Retries
• Write DMA Without Retries
• Read Sectors Without Retries
• Write Sectors Without Retries
• Read Long
• Read Long Without Retries
• Write Long
• Write Long Without Retries
• Write Verify
• Write Verify Without Retries
• Read Verify Without Retries
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After selecting a  Command, configure the appropriate parameters, then 
click OK.  The parameters are explained below:

Command Code
Displays the code for the whatever Command was selected in the menu.

Features
Features refers to the contents of the Features register.  To trigger on 
Features, enter a value in the box.  This option is context-sensitive and is not 
available for all Commands.

Sector Count
Sector Count refers to the contents of the Sector Count register.  To trigger 
on Sector Count, enter a value in the box.  This option is context-sensitive 
and is not available for all Commands.

Sector/Cylinder/Dev/Head Mode
Select this option to activate the following parameters:

Sector Number - Enter a value to trigger on the Sector Number register.

Head Number - Enter a value to trigger on the Head Number register.

Cylinder Low - Enter a value to trigger on the Cylinder Low register.

Cylinder High - Enter a value to trigger on t he Cylinder High register.

LBA Mode
Select this option to activate LBA (Logical Block Address) addressing.  
Then enter an address into the text box.  The term LBA defines the 
addressing of data on the device by the linear mapping of sectors.
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Triggering on ATAPI Commands
SATracer can now trigger on ATAPI 5/6 command packets.  To trigger on 
ATAPI Commands, perform the following steps:

Step 1 From the Events page in the Recording Options dialog box, 
select Command Level.  

Step 2 From the drop-down menu marked Select Command name, 
select Packet.

Step 3 From the Events Group list on the left, select Short FIS 
Pattern.

Step 4 From the Type menu, select Data.  
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Step 5 Click the Edit button.  The Pattern Editor will open.  

Step 6 Enter a bit or hex pattern for the Command OpCode in the 
box(es) marked Data.  In the example above, a 28 has been 
entered.  0x28 is the OpCode for a Read(10).  Other 
examples:  Inquiry = 0x12; Write(10) = 0x2A

Step 7 Click the Actions tab at the top of the Recording Options 
dialog.  You should see two buttons on the left side marked 
Command and FIS Data Button.  These buttons will be 
connected by two arrows to the Trigger button.

Step 8 Drag the Command button into the FIS Data Pattern button 
at the top of the dialog box.  This action should cause the two 
buttons to sit immediately adjacent to one another as shown 
below.  This configuration means "When a Command is 
followed by a FIS data pattern of xyz, trigger" - in other 
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words, "Trigger on the ATAPI xyz."    
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6.4  Recording Options - Actions
The Actions screen is used to configure the type of action that the analyzer 
will perform when key events are encountered in the trace. The Actions 
window is like a chalk board - it graphically displays events and actions as 
buttons, and lets you establish relationships between them. 

Simple or complex configurations can be created in the Actions window. 
Simple configurations involve a single event and action, as shown above. 
This example reads: "Trigger when the specified error occurs." 

Complex configurations involve multiple events. Multiple events can be 
combined in different ways to create event sequences and event counts. 
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Event Sequences
An event sequence is two or more events (up to six) that are strung in a series 
to a trigger button. The sequence below reads "Look for an error followed 

by a FIS, and then by a WTRM Primitive Identifier.  When you see this 
sequence, trigger."  The events do not need to immediately follow each 
other - there can be intervening events.  

Event Counts
An event count is an Event button connected to a Counter button. The 
Counter tells the analyzer to look for multiple instances of an event before 
triggering. 
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Event count are created by clicking on an Event button and then clicking on 
one of the counters on the right side of the window. Afterwards, the Counter 
button will reposition itself directly below the associated Event button. 
Together, the Event button and the Counter button will point to the Trigger 
button.  

You set the counter to a particular value by clicking the blue dot in the 
corner of the button and enter a value. For details see Section 6.8, “Counting 
Events” on page 110.

Actions Window Layout
The Actions window displays three groups of buttons that can be connected 
by dragging the mouse: Event buttons, Action buttons, and Counters.

Event Buttons
Event buttons represent the events you selected in the Events window. 
These buttons are created automatically when you make your choices in the 
Events window. If no events are selected, no Event buttons will appear.

By default, Event buttons are connected to the Trigger button. 

Counters
Event
Button

Action
Buttons
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Action Buttons
Buttons marked Trigger, Filter In/Out, and Restart are Action buttons. 
These buttons determine the outcome of an event.

Trigger Button - When an Event button such as an Error is connected by a 
line to the Trigger button, the association tells the analyzer to trigger 
the end of the recording when the selected event occurs. 

Filter In/Out Button - Tells the Analyzer to filter in or out events from the 
recording. Filtering Out excludes specified traffic.  Filtering In lets 
you specify the types of traffic that should be included in the trace.  

Filtering functions as a way of excluding unwanted traffic in order to 
preserve recording memory and thereby increase amount of desired 
traffic in your trace. 

The polarity of this button is toggled from Filter In to Filter Out and 
vice versa by clicking the blue dot on the button and selecting a 
polarity from the pop-up menu.

Restart - This button is used to restart Counts and Event Sequences. See 
below for an explanation of Counts and Event Sequences. 

Counter Buttons
Buttons marked Count1 and Count2 are counters. Counters are used to 
create triggers based on several occurrences of the same packet type. 
Counters let you create configurations such as "Trigger following the 6th 
FIS Length Error." 

Counters only work with triggers. You cannot connect a counter to the Filter 
In/Out button or to the Restart button.
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6.5  Connecting Events to Actions
Event buttons can be linked to Action buttons by clicking on an Event 
button and then clicking on an Action button. A line will join the newly 
associated buttons. 

The following steps show how to connect Event and Action buttons:

Step 1 Open the Events tab and select a single event.

Step 2 Click the Actions tab.

The Event you selected will display as a button on the left side of 
the Actions window. By default, this button will be connected to 
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the Trigger button. The configuration below reads "Trigger when a 
H->D FIS occurs." 

Step 3 Click on the Event button. 

The elastic arrow appears.
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Step 4 Drag the arrow to the desired Action button.

Step 5 With the pointer over the desired Action button, click the left 
mouse button again.

The arrow is replaced with a black line, and the Event button is now 
connected to the Action button. 

Note Not all events can be connected to the Filter or Restart buttons 
(for example, errors). 
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If an Event button is linked to a counter and then to a Trigger, it indicates 
that the analyzer should trigger following a count of several instances of the 
event. The number of times that the analyzer should count the event is 
determined by the number visible in the counter button. You set this number 
by clicking the blue dot in the counter and entering a value.

6.6  Triggering from an Event in a Set
When you select several events in the Events window, the Actions window 
displays the events as shown below. Each Event button will have its own 
connection to the Trigger button. In this configuration, the Analyzer will 
trigger a recording from any one of these events.

See the following example:

To trigger on an event in a set, follow these steps:

Step 1 From the Events window, select two or more events.

Step 2 Open the Actions window. The events will display as shown 
above. 
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6.7  Creating an Event Sequence
When multiple events are selected in the Events window, you create what is 
called an event sequence. An event sequence is the stringing together of 
events so that the analyzer triggers on the selected sequence in the specified 
order. 

SATracer allows you to link up to six events together in a sequence, and up 
to two sequences in an action. 

In the following example, the Analyzer is told to trigger when Errors then 
FIS1 then P1 events occur: 

To create an event sequence, follow these steps: 

Step 1 From the Events window, select two or more events.

Step 2 Click the Actions tab. The events you selected appear in the 
Actions window with separate lines connecting to the 
Trigger button.

Step 3 To sequence the buttons, click an event button. An elastic 
arrow appears. 

Step 4 Point the arrow to another Event button. The Event buttons 
move next to each other in sequence, as shown in the 
example above.  
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6.8  Counting Events
Counters count multiple occurrences of an event. When the analyzer is 
configured for counting, it searches for multiple occurrences of an event 
such as an error and triggers when the last event in the count occurs. 

When a counter is in use in the Actions window, the counter 
button will be relocated below its associated Event button 
and then connected by a line to the Trigger button. The 
Counter will display a number that indicates the number of 
events that the Counter is set to look for. 

The buttons marked Count1 and Count2 provide a way of triggering after 
a number of events have passed, such as "Trigger after the 20th error." 

Counters have blue dots in their top left corner that provide access to pop-up 
menus. The menus provide the means of setting the counter value. The 
counter can be set between 1 and 65,535. 

To connect an event to a counter, follow these steps:

Step 1 Click the Event tab and select an Event such as Error. 

Selecting an event causes an Event button to automatically appear 
in the Actions tab. 

Step 2 Click the Actions tab. 

The tab displays an event button that is connected to the Trigger 
button on the right.
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Step 3 Click the Event button. 

An arrow appears that connects the Event button to your mouse 
pointer. 

Step 4 Click one of the two counters.

The event automatically connects to the Counter button and then 
connects to the Trigger button. 

Step 5 Click the blue dot in top right corner of 
your selected counter.

A pop-up menu opens. This menu lets 
you configure the counter.

Step 6 Choose Change Counter Value.

Step 7 Set the counter to a value of your choice, and click OK.
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6.9  Triggering External Output
The Actions window has options enabling the analyzer to send an output 
signal through a BNC cable or an RS-232 cable and breakout board to an 
external device such as an oscilloscope. 

Cabling
To set up the analyzer for signal output, you will first need to connect the 
analyzer to the external device using a BNC or RS-232 cable.

Using a BNC Cable
If using a BNC cable, connect the external device to one end of the cable 
and connect the other end of the cable to the output connector marked "Ext. 
2" on the back of the analyzer.

Using an RS-232 25-pin Cable
If using an RS-232 cable, you will also need to use a CATC breakout board 
and alligator cables. Connect alligator cables from the external device to one 
or more Data pins on a breakout board. Then connect a 25-pin RS-232 cable 
from the breakout board to the 25-pin connector on the back of the analyzer 
marked "DATA IN/OUT."

Once the analyzer is connected, you will need to configure the Recording 
Options so the analyzer will send an output signal.

An SATracer placed between a host and hard drive. The analyzer monitors Serial ATA
traffic and waits for a trigger event. When the event occurs, the analyzer sends an 
output signal through the breakout board to the logic analyzer. 
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Setting External Output Options
To configure the analyzer for signal output, follow these steps:

Step 1 If it is not already open, open the Actions window in Recording 
Options. You should see Event buttons on the left side of the screen 
representing the events you selected in the Events window of 
Recording Options.

Step 2 Click the blue dot on an event button representing the 
event you wish to cause an output signal. For example, 
if you want the analyzer to send an output signal when it see an error, 
to trigger an output signal based on an error, click on the blue dot in 
the Error button. 

 The following menu appears:

The menu offers three choices:

Enable External General Purpose Output - This 
option causes an output signal to be generated 
AND triggers the end of the recording. When selected, a small 
arrow appears on the event button, indicating that output signalling 
has been enabled. Also present is a line between the event button 
and the trigger button. This line indicates that the analyzer is set to 
trigger the end of its recording. 

Enable External General Purpose Output Only - This option 
causes an output signal to be generated without triggering the end 
of the recording. When enabled, a small arrow on the event button 
indicates that the analyzer is configured to send an output signal. 
You will see that the no line between the selected event button to 
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the trigger button - this indicates that the analyzer will continue 
recording without triggering.

External Output Form - This option presents a menu with options 
for setting the form of the output signal. Your choices are:

•  Pulse Low - Causes the Analyzer to transmit a 0.2-volt, 
67-nanosecond signal.

•  Pulse High - Causes the Analyzer to transmit a 3.2-volt, 
67-nanosecond signal. This is the default format. 

•  Toggle -    Causes the Analyzer to send a signal that toggles with 
each trigger event between a continuous 3.2-volt 
signal and a continuous 0.2-volt signal.

Step 3 Choose "Enable External General Purpose Output" or "Enable 
General Purpose Output." A small arrow will appear on the selected 
event button.

Specifying Pulse Signal Outputs
Once Output signalling has been enabled, you can configure the output 
signal to Pulse Low, Pulse High, or Toggle. 

To configure the output signal, follow these steps:

Step 1 Click the blue dot on an event button that has a small arrow attached. 

Step 2 In the resulting menu, choose External Output Form.

Step 3 Choose Pulse Low, Pulse High, or Toggle.

6.10  Setting Multiple Conditions with Counters
You can create multiple event conditions by linking a counter to multiple 
events or by linking two counters to two or more events.
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Sequencing with Counters 
When two or more Events are connected together and then to a counter, a 
condition is created such as the one shown below. This example reads: 
"When P1 occurs then P2 occurs 6 times, then trigger."

To link two or more Events to a counter, 

Step 1 Select two or more events in the Events window (Recording 
Options > Events). 

Step 2 Click the Actions tab.

Step 3 Click one of the event buttons. An elastic arrow will appear 
on your mouse pointer.

Step 4 Click one of the Counters. The Counter button will move 
directly under the Event button.

Step 5 Click another Event button. An elastic arrow will appear on 
your mouse pointer.

Step 6 Click the Counter button that is below the first Event button. 
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Linking Two Events to Two or More Counters
If an Event is linked to Count1 and a second event is linked to Count2, it 
creates an "or" condition. The example below reads "Trigger when Count1 
OR Count2 has reached their specified values."

6.11  Filtering Traffic
Filtering lets you exclude unwanted traffic so you can preserve recording 
memory and increase the amount of desired traffic in the trace. The blue dot 
in the upper left corner of the Filter button gives you a menu of the two filter 
options: Filter In and Filter Out.

What Happens to the Trace When You Filter Out Traffic
When traffic is filtered out at the FIS level, you will see a horizontal line 
appear in the trace where the item was removed. When traffic is filtered out 
at the Sequence level, SATracer shows where primitives were filtered and 
removed. 
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Filtering Idle Sequences
When there is an idle state on the Serial ATA bus (i.e., a bus with no FIS 
traffic), idle traffic remains. Idle traffic is represented in the trace as Idle 
Sequences that contain ALIGN primitives and XXXX cells. These Idle 
Sequences are largely irrelevant when debugging at the protocol level. 
SATracer can display the data patterns transmitted within idle traffic.

To remove Idle Sequences, follow these steps: 

Step 1 Open the Events tab in Recording Options.

Step 2 Select Primitive Identifiers.

Step 3 Select Sync from the first drop-down menu, and select Align 
from the next menu.

Step 4 Select the Actions tab.

Step 5 Connect both primitive objects to Filter Out.

This will effectively remove Idle Sequences from a trace.

Setting the Filter to Filter In or Filter Out
To change the polarity of the filter, click the Blue dot in the corner of the 
Filter button. A pop-up menu appears with the following choices:

Filter In - Tells the analyzer to include only the selected 
event(s) in the trace. 

Filter Out Tells the analyzer to exclude the selected 
event(s) from the trace.

Note: Some events, such as errors, cannot be filtered.

How to Use Filters
To filter an event in or out from a recording, follow these steps: 

Step 1 From the Events window, select one or more events.
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Step 2 Click the Actions tab to open the Actions window.

Step 3 Click an Event button, then click the Filter In/Out button.

A line will connect the Event button to the Filter In/Out button.

Step 4 Click the blue dot on the Filter In/Out button.

A pop-up menu will appear with choices for Filter In and Filter 
Out.

Step 5 Select one of the two choices.

The polarity of the Filter In/Out button will change to your selection.

6.12  Restarting Sequences and Counters
The Restart button is used to create conditional statements with sequences 
and counts. 

When an event is linked to the Restart button, the Analyzer 
restarts any counting or sequencing it is performing if that 
event is found. 
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Restarting a Sequence
For example, in the illustration below the Analyzer is told: "Trigger 
following a sequence of an FIS Length Error, a Sync Primitive, and a Data 
FIS Pattern. However, if a Bus Condition occurs during the sequence, restart 
the search."

Restarting a Count
The Restart button can be used to restart counting. If a Event count has been 
defined, adding a link between another event and the Restart button tells the 
analyzer to restart the count any time the Restart event has been found. This 
is best explained with an example. In the screenshot below, the analyzer is 
configured to trigger following the sixth FIS Length Error, but if a Bus 
Condition event occurs anywhere during the count, restart the count. 
 119



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
6.13  Saving Recording Options
To complete your recording options settings, use the features at the bottom 
of the Recording Options screen. These features remain the same no matter 
which of the three recording options windows in which you are working.

• Click Save to save the currently specified recording options for use 
in future recording sessions. Any file name can be specified, though 
use of the .rec extension is recommended; if no extension is 
specified, .rec is added by default.

• Click Load to load a previously saved *.rec file, and restore a 
previous set of recording options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.rec. Whenever you start up the 
Analyzer, it automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this window.

• Click Cancel to cancel any immediate changes you have made and 
exit the Recording Options menu.

6.14  Recording Bus Data
To start recording Serial ATA traffic once the appropriate Recording 
Options have been set, perform the following steps. 

If you have created any event Triggers, be sure to select Event Trigger under 
the General tab in the Recording Options dialog box. 

Step 1 From the Record menu, select Start.

Your recording session can continue until it has finished naturally 
or you might need to stop manually by clicking  on the Tool 

bar, depending on how you set the Recording Options.

Step 2 To manually stop recording, select Stop from the Record 
menu.

When the recording session is finished, the bus traffic is saved to 
the hard drive as a file named data.sat or whatever name you 
assign as the default filename. 

Step 3 To save a current recording for future reference, select 
Save As from the File menu.

Step 4 Give the recording a unique name and save it to the 
appropriate directory.
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6.15  Saving a Trace
You can save all or part of a trace with the Save As command:

Step 1 Select File > Save As.

Step 2 Click the Save Range option.

Step 3 In the boxes marked From and To: Select Sequence, FIS, or 
Command from the drop-down menus. If FIS and/or 
Command are grayed out, you will need to close the Save As 
dialog box and decode these levels. 

Step 4 Enter the range that you wish to save.

Step 5 Click Save.

6.16  The Partial Upload Utility
Partial Upload is a utility that allows you to upload a portion of a trace to 
the PC while leaving the original recording intact in the analyzer’s buffer. 
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Partial Upload lets you target a portion of a trace, view that portion and, if 
need be, reload a new portion. The utility thus gives you an opportunity to 
review different parts of a recording as many times as needed until you have 
found the traffic that most interests you. 

The Partial Upload utility presents a dialog box with a slide bar for 
specifying the starting and ending point of the buffer the user wishes to 
upload after a recording is made. This will allow the user to record the 
maximum buffer size, and upload a portion of it to see if it is what the user 
needs, or simply work on portions of it without the need to upload the entire 
buffer into memory. 

If you execute a re-upload, the analyzer opens the Partial Upload dialog box 
again and lets you reselect the buffer you want transmitted to the PC. The 
process does not affect the trace in the analyzer’s memory - hence you can 
edit and re-edit a trace as often as you like.

When to Run Partial Upload
This utility needs to be enabled before it can be run. You can enable it either 
before or after recording a trace. 

You enable Partial Upload by pressing .

Enabling Partial Upload Before Recording 
If you enable Partial Upload before recording a trace, a dialog box opens 
asks you to set the start and end points of the traffic you wish to upload.  

Drag the slide bars or enter values into the boxes, then press OK.

Once the recording is complete, only the selected range of traffic will upload 
and display.

You can repeat this process as often as you would like by pressing . 
When done, you can preserve the edited trace with the File >Save As 
command.
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7.  Display Options
Use the Display Options menu to specify the way CATC Trace information 
is displayed.

From the Setup menu, select Display Options.
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7.1  General Display Options
Use the General Display Options to specify the basic appearance of a Trace 
view.

• Zoom Level: Adjustable in discrete increments from 10% to 200% 
percent.

• Enable Tips: Select to enable Tool Tips with explanation text to 
pop up when you position your cursor over various fields in the 
Trace View.

• Wrap: Causes packets to wrap within the window if their length 
exceeds the width of the window.

• Hierarchy Lines:  Adds faint lines to the left side of the trace 
window connecting packets, FISs and Commands into an explicit 
hierarchical relationship.

• Right click cell context menu:  Activates the right mouse button 
for opening cell context menus.

• Trace Viewing Level: Allows you to select the hierarchical level at 
which traffic is displayed.

• Command View:  Presents options for viewing ATA Commands 
in ATA/ATAPI-5 or ATA/ATAPI-6 formats.

• Time Stamp Location:  Presents options for displaying the Time 
Stamp at the beginning or end of a Sequence, FIS or Command.

• XXXX Pair Display:  Presents options for displaying XXXX pairs 
in a collapsed format with a count, or expanded format.

• Show RAW Data Scrambled/Unscrambled: Select to show raw 
data in Scrambled or Unscrambled format. 

• Descramble XXXX data:  Shows XXXX data descrambled.

• Display Configuration Name: Comment field associated with the 
*.opt file containing the current Display Options values. You can 
also create and store your unique Display Options for future use. 

To create a new Display Options file, follow these steps:

Step 1 Enter a comment for the new file in the Display 
Configuration Name field.

Step 2 Click Save...

Step 3 Specify a filename (*.opt).

Step 4 Click Save.
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7.2  Setting Color, Formatting, and Hiding Options
Click the Color/Format/Hiding tab on the Display Options screen.

Use this window to customize the colors and formats associated with each 
field in the Trace view. You can also use this window to hide fields within 
the trace.

Setting Color Display Options 
To change the colors of elements in the trace, select an item in the Group 
and Color column and use the color pallet screen on the right to make the 
desired changes.

Note The color of an Invalid Data (packet error) field cannot be 
changed; it is permanently set to red.

Use this window to customize the colors associated with each field in the 
trace.  You can experiment with these options to achieve the color 
combination best suited to a particular graphic system.
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You can also customize the colors by using the options in the Custom tab. 

Changing Field Formats
To change field formats, select an item under the Group and Color column.  
This action will enable the formats radio buttons on the right.  The format 
types change with respect to the item selected under the Group and Color 
column.  For example, if FIS Types is selected, the following displays: 

The following formats are available:

Note Not every format is available for every item.
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Hiding Display Options
To hide one or more fields in the trace, select the 
appropriate item from the Group and color column, click 
the checkbox marked Hidden, and click the Save button. 

You can also hide Sequences from a trace by selecting the desired options 
from the checkboxes.   

7.3  Level Hiding Options
The Level Hiding tab allows you to hide FISs, Idle Sequences and other 
types of traffic.  To hide traffic, select one or more items, then click Save. 

Level Hiding Parameters
The Level Hiding window displays the following options:

FIS Types
Displays a list of FIS types.  Selecting one or more FIS types causes the 
selected types to be hidden from the trace.
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To select multiple items from the FIS Types list, press the Control button 
down on the keyboard and click the desired options.   Use the same 
procedure to deselect the items. Hold down the control key, and click the 
items until all are deselected. 

Traffic Direction
Hides traffic by its direction.  You can select up to four directions.

Misc
Allows Idle or Align primitives to be hidden from the trace.

Bus condition sequences
Hides Out of Band signals.

Power Management Seq
Hides traffic for devices in Slumber mode or in Partial mode.

Partial Mode and Slumber Mode are Power Management states in which the 
PHY logic is powered, but is in a reduced power state.  In both modes,  
signal lines on the interface are at a neutral logic state (common mode 
voltage).  The exit latency from this state is no longer than 10 ms.

Port Number
Hides traffic to or from one or more ports.

7.4  Saving Display Options 
To complete your display options settings, use the features at the bottom of 
the Display Options window. These features remain the same no matter 
which of the four Display Options windows you are working in.

• Click Save to save the currently specified display options for use in 
future sessions. Any file name can be specified, but you must use 
the .opt extension. If no extension is specified, .opt is added by 
default.

• Click Load to load a previously saved *.opt file, thus restoring a 
previous set of display options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt. Whenever you start up the 
Analyzer, it automatically loads the default.opt file if one exists.

• Click OK to apply any changes you have made to Display Options 
and close this dialog box.

• Click Cancel to cancel any immediate changes you have made and 
exit the Display Options menu.
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• Click Apply to apply your changes while keeping the Display 
Options window open.
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8.  Reading a CATC Trace

8.1  Trace View Features
SATracer/Trainer trace viewing software display makes extensive use of 
color and graphics to fully document the captured traffic.  Sequences are 
shown on separate time-stamped rows, with their individual fields both 
labeled and color coded.  Data fields can be collapsed to occupy minimal 
space in the display (which can in turn be zoomed in and out to optimize 
screen utilization).  Pop-up Tool Tips annotate sequence fields with detailed 
information about their contents.

The display software can operate independent of the hardware and so can 
function as a stand-alone Trace Viewer that may be freely distributed.

8.2  Sequence, FIS, and Command Views
The default display mode is Sequence view. The Serial ATA trace can also 
be viewed in Frame Information Structure (FIS), and Command views.

What is a Sequence?
A Sequence is a CATC-defined term for a serial stream of primitives and 
data that is sent from a host to a device or vice versa.

Sequences usually begin at X_RDY (or PMREQ_S/PMREQ_P) and end at 
the next X_RDY (or PMREQ_S/PMREQ_P).

Filter out is not applicable to the following primitives: X_RDY, R_RDY, 
SOF, PMREQ_P, PMREQ_S, EOF, CONT.   

Changing Display Levels 
To switch between the Sequence, FIS, and Command 
views, click the respective buttons on the right hand side of 
the Tool Bar.
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When you click the Seq button Sequence view appears as below: 

When you click the FIS button, the FIS view appears as below:

When you click the CMD button, the Command view appears as below:

You can also expand the views by clicking the triangle in the Sequence, FIS, 
or Command views. The following is an example of an expanded Command 
view and its hierarchical relationship between Sequences and FIS:

You can also get additional information on fields by holding your mouse 
over selected fields as shown in the following example:
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You can also set the hierarchical view by selecting checkboxes in the Trace 
Viewing Level Options in the Display Options window. 

8.3  Timestamp Location
The timestamp in the trace appears either at the beginning or end of the 
CATC trace - depending on how you configure the SATracer Display 
Options. Select Setup > Display Options > General to set the timestamp 
location.  

When set to Beginning of sequence, the Timestamp will display at the 
beginning of the trace as follows:
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When set to End of sequence, the Timestamp will display at the end of the 
trace as follows:

8.4  Delta Cells 
Delta cells occur before Timestamp cells 
to show the difference in time between 
two Sequences. FISs, or Commands. 

8.5  View Raw Bits
SATracer allows you to view low-level 8B/10B values for Serial ATA 
traffic. You can expand a specific sequence to view the raw bits by right 
clicking on the Sequence number and selecting Show Raw Bits. 

To view Raw Bits, follow these steps:

Step 1 Click on the first cell of a Sequence.

Note Raw Bits can be viewed only in Sequences.
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Step 2 Select Show Raw Bits. 

The data 8b and 10b field can be displayed in either binary or 
hexadecimal by clicking on the column header, as shown below.

Window Layout - The window displays packets as rows and physical lanes 
as columns. 

Data Appearance - To change the format of the data, select from following 
options:

• 8b - Click the column heading to show hexadecimal values.

• 10b - Click the column heading to show hexadecimal values.

Navigation - To move to the previous or next packet in the trace, click one 
of the two Sequence buttons at the bottom of the window:

• Prev - Displays data for the previous sequence in the trace.

• Next - Moves to the next sequence in the trace.

Running Disparity Error - If SATracer detects Running Disparity Errors 
it will display a red question mark symbol in the err column.

You can use the Previous and Next buttons to scroll the both sides of the 
display at the same time. You can use the keyboard to scroll each side 
separately.  By default, the Rawbits view shows the first 5000 10b codes. 
You can use the drop-down list to view additional 10b values. Selecting the 
maximum length shows the full sequence. 
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The Raw Bits view includes search tools for navigating to Primitives within 
the Sequence. It will only show the primitives that occur in the sequence. 
Use the Search drop-down list to use this feature. 

The 8-bit codes change to 10-bit codes before they get transmitted. 

Running Disparity
Running Disparity is a binary parameter with either the value negative (-) or 
the value positive (+). After receiving any encoded character, the receiver 
shall determine whether the encoded character is valid using the running 
disparity parameter as a checksum.  The receiver will then calculate a new 
value that is either the opposite of the previous character or neutral. The 
ability to view changes in Running Disparity polarity is an important part of 
the debug process.  The CATC raw bits view displays the running disparity 
of the 10bit code in the column following the raw bits. 

Note: For a more complete definition of Running Disparity, please refer to 
the Serial ATA Specification Version 1.0.

Exporting 10b/8b Raw Bits
You can export 8b/10b raw bit codes to a file in a spreadsheet format.  See  
Section 10.3, “Exporting 10b/8b Raw Bits” on page 171. 

8.6  Set Marker
The Set Marker works in conjunction with the Go to Marker feature.

You can define a unique marker for each sequence by following these steps: 

Step 1 Click on Sequence # for the sequence you wish to mark.
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Step 2 Select Set Marker.

The Edit Market for Sequence # comment window appears.

Step 3 Enter your comment. 

Step 4 Click OK.

A marked sequence is indicated by a vertical red bar along the left 
edge of the sequence # block: 

8.7  Edit or Clear Marker
To clear or edit comments associated with a sequence marker, 

Step 1 Click on Sequence # for the chosen packet.
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Step 2 To edit the marker comment, select Edit Marker.

The Edit Marker for Sequence # comment window appears.

Step 3 Edit the comment as desired.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker.

The vertical red Marker bar disappears.

8.8  Showing Sequences in Zoom View
SATracer has a zoom feature that allows you to isolate a sequence in a trace 
and scroll through it line by line. This feature is needed for sequences with 
large payloads. 

When scrolling through a trace that contains sequences with large payloads, 
it will scroll from one sequence to the next. In this case, you might scroll 
past parts of the sequence that are off the display window.  To scroll through 
a sequence line by line, use the "Show Sequence in Zoom View" option. 
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Click the first cell of a Sequence and select Show/Hide Sequence in Zoom 
View from the pop-up menu.

A new window appears showing the isolated sequence:

Step 6 If the Sequence is very long, use the scroll bar in the Zoom 
View window to scroll through the Sequence.
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Timing Calculations in Zoom View
The Zoom View allows you mark primitives and calculate time differences 
between two primitives. You can mark points in the sequence for time 
calculation and set jumping points in that sequence. These markers are 
deleted when moving from one sequence to another. 

Step 1 Click on a Sequence in a Trace, and select Show/Hide 
Sequence Zoom In View from the pop-up menu.

Step 2 Click on a cell in the Zoom In view, and select Set Marker.

Step 3 In the Edit Marker window, type the name of the new marker. 
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The marker will be displayed in the Zoom In view.

The markers appear in the trace as follows:

Step 4 Click on a cell, and select Calculate From in the pop-up menu.

Step 5 In the Zoom In Calculator, select the ending point and units, 
and click Calculate.
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Search for Errors within Zoom-in View
Click in a field of interest to access a context-sensitive menu.  The menu 
gives you options for searching for Errors and Primitives within the 
Zoom-in view. 

The sequence must be fully expanded in the Zoom View to search within it. 
Collapsed cells can not be searched. 

Errors that are marked in a sequence and that can be searched for are:

• CRC Error

• Code Violation

• ALIGN Error

• Running Disparity Error

• Flow Control Signaling Latency

You can see Errors marked with red cells in a trace, and the tool tip contains 
the error description. 
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Searching for Primitives within Zoom-in View
The right-click menu also allows you to search for Primitives within the 
Zoom-in view.  

8.9  Expanding and Collapsing Data Fields
You can expand a Data Payload field to view it in greater detail or collapse 
it when you want a more compact view. SATracer/Trainer allows you to 
expand and collapse the data payload information in four ways: 

• Clicking the small triangular arrows on the left side of the data 
payload field

• Clicking and holding down the mouse button on the triangular 
button on the left side of a data payload field. This action will 
expand or collapse data fields for all Sequences/FISs/Commands 
throughout the trace

• Double-clicking anywhere in the payload field

• Clicking in the data payload field and selecting Expand/Collapse 
Data in the pull-down menu. 

When you select "Expand Data," only the first 100 dwords are shown. To 
view all of the dwords, select "View Data Block."
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This section describes expanding or collapsing data payload by using the 
menu:

Step 1 In the Serial ATA trace, click in a Data Payload box.

Step 2 In the Data Field menu, select Expand Data.

The Data Payload box in the Serial ATA trace expands to show 
more detailed description of the data:

To collapse data, follow the same steps described above, and select 
Collapse Data. 

You can also expand or collapse all data payload fields within a 
trace by using the above menu. 

Expanding and Collapsing XXXX Pairs
XXXX pairs can be displayed as collapsed and expanded, as shown in the 
following examples:
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Collapsed view of XXXX pairs

Expanded view of XXXX pairs

8.10  View Data Block Window
The View Data Block command opens a dialog box that lets you display and 
navigate the data within FISs and Commands.  This dialog box gives you 
several format choices for the data:  binary, hexadecimal, ASCI, and 
decimal.  It also gives you the ability to navigate through data fields within 
different FISs and Commands.

To access the View Data Block window,

Step 1 Click  or  to decode to the FIS or Command level.

Step 2 Locate a FIS or Command with a data field such as the one 
shown below: 

Step 3 Click in the Data field to open a pop-up menu.

Step 4 Choose View Data Block from the menu.  The View Data 
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Block window opens.  

Description of View Data Block Window
The View Data Block window (henceforth called the View window) 
displays the raw data for the selected Data field.  Data is displayed in up to 
four formats, a column per format.  The window has several options for 
navigating through Data blocks.

Save.  Saves the currently displayed data block into a text file.

Previous and Next.  These buttons cause the View window to jump 
to the next FIS or Command that has a data block and display that 

data block.

Data Format Display. Creates a column for the specified 
data format and then displays the currently selected data 

block in that format.  

MSB/LSB Format.  Begins the data string with the Most 
Significant Bit (MSB) or  Least Significant Bit (LSB).

Format Line.  Opens a dialog box for setting DWORD length.  The 
default is 4 dwords.

Synchronize Options.  Configures the mouse’s 
scrolling behavior within the View window.  The 

menu presents three scrolling options:
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Update only on request -  Locks whatever data block currently is on display 
in the Data window unless overridden by  a direct request.  There are two 
ways to make a request -- by clicking on the  buttons or by 
right-clicking in the trace on a data block and selecting View Data Block 
from the pop-up menu.

Update on click - Repositions the Data window to whatever data block you 
click on in the trace window.

Update on scroll - Synchronizes trace scrolling with the Data window.  As 
you scroll the trace, the Data window will reposition to show the data block 
for the FIS or Command at the top of the trace window. 

Scroll to Offset.  Repositions the Data window to whatever 
offset you enter in the Offset box.  You can enter an offset 
value in decimal or hexadecimal. 
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9.  Searching Traces
SATracer has several search commands that enable you to navigate a trace 
in search of key events such as errors and triggers.  These commands are 
launched from the Search menu.

To view the search options, click Search in the Menu bar.

9.1  Go to Trigger
To display a Trigger Event, select Go to Trigger from the Search menu.

The Trace View is repositioned with the first sequence following the 
Trigger event (or the sequence that caused the Trigger) at the top of your 
screen.

9.2  Go to Sequence/FIS/Command
To display a specific sequence, follow these steps:

Step 1 From the Search menu, select Go to 
Sequence/FIS/Command... 

The Go to Sequence/FIS/Command window appears.
 149



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
Step 2 From the Go To pull-down menu, select Sequence or FIS.

Step 3 Enter the number of the sequence, FIS, or command you 
want to display.

or

From the pull-down menu on the right side of the window, select 
the trigger sequence or marker.

Step 4 Click OK.

The trace view is repositioned with the selected item at the top of 
your screen.

9.3  Go To Time
To reposition the trace to a particular time event, use the Go To Time 
command.

Step 1 From the Search menu, select Go to Time ... 

The Go To Time window appears.

Step 2 In the box marked Time, enter a time value in seconds.

Step 3 Click OK.

The trace view is repositioned with the selected time at the top of 
your screen.
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9.4  Go to Marker
To instruct the Analyzer to display a marked sequence, follow these steps:

Step 1 From the Search menu, select Go to Marker.

Step 2 Select the desired sequence, FIS, or Command from the 
displayed list.  

The Trace View is repositioned with the selected item at the top of 
your screen.

Selecting Search > Go to Marker > All Markers will cause a 
dialog box to open with a list of all markers in the trace.  The dialog 
box offers options for editing, deleting, and copying markers.

Note The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses 
following each marked sequence are added or edited with the Set 
Marker feature. Please refer to Set Marker in Reading a 
CATC Trace.
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9.5  Go To
The Go To feature takes you directly to an event in a Trace such as an 
ATAPI command by allowing you to search by a specific criteria. Only the 
items present in a trace will be displayed in the Go to menu. If an item is not 
present in a trace, it is greyed out in the menu.  

To apply the previous Find parameters to the next search, select Find Next 
from the Search menu.

9.6  Find
Find is a utility for conducting searches of one or more events within a 
trace. Find allows you to search different hierarchical levels within the trace 
- Sequences, FISs, and Commands.  To start find,

• Select Find... under Search on the Menu Bar

OR

Click  in the Tool Bar.
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You see the User-Defined Find Events screen:

The Find window divides into three areas: 

Left area --  Display options for setting the search level, direction and 
origin.   The top left box is context-sensitive. In order for the FISs and 
Commands to be active, you will need to decode these levels in the trace. 

Center area  -- Controls the event groups to be searched. The selection you 
make will display further choices on the right side of the Find window. At 
the bottom are three options called Union, Intersection, and Exclusion that 
are used with multi-criteria searches. These options are explained below.

Right area -- Controls the specific events to be searched within the trace. 
The box in this right section displays events from the selected Event Group. 

The right area is context sensitive - the Event Group selected in the Center 
Area determines what types of events display on the right. For example, if 
"Primitive Type" is selected, the right area will display a list of Primitive 
types. Bold entries indicate items that actually occurred in the trace.

In the example shown above, Primitive Types is selected. The right side of 
the screen shows all of the Primitive Types that occurred in the displayed 
trace.
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Complex Searches
When conducting complex searches in the Find 
dialog box, you first push a decode button in the 
toolbar to enable Sequence, FIS, or Command in the 
Search for... box.

In the example shown on the right, all of the Search 
for choices are enabled, and Sequences is selected.  
The Event Groups box in the Find dialog contains 
available choices based on the selection. 

After you have selected a choice in the 
Event Groups, the box on the right of 
the Find window will present choices 
based on your selection. In the 
following example, the box displays the 
primitive types that are available in the 
trace:

Event Groups
Event Groups are categories of events that can occur in a trace. Clicking on 
an Event Group will display a list of Event types on the right side of the Find 
window that occur within each Event Group.

Union, Intersection, and Exclusion
If multiple events are selected, use the options Union or Intersection to 
conduct the search. 
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Union is used to search for any selected event: "Find x or y." Union lets you 
tell the Analyzer to search the trace for any of any of the selected items.    

Intersection is used to search for all selected events: "Find x and y." 
Intersection lets you tell the Analyzer to search the trace for any packet 
having all of the selected events.

Exclusion is used to exclude selected traffic from the trace. Exclusion is 
used with Union and Intersection --i.e., you select Exclusion with Union or 
Intersection. 

• Exclusion + Union -- Exclude packets with any of the specified events. 

• Exclusion + Intersection -- Exclude packets with all of the specified events. 

Using Find
Step 1 Select the display level to be searched from the Search For box on 

the left side of the window. 

For example, to search through Commands, select Commands. The 
display level affects options presented in the Events Group box.

Step 2 Select a search direction and origin.

Step 3 Select one or more events from the Events Group box.

Your choices will affect options displayed on the right side of the dialog.

Step 4 If you have selected two or more criteria, then select either:

• Union: Find all packets that match ANY of the specified events. 

• Intersection: Find all packets that match ALL of the specified events.   

If you want to selected events from the trace, then select:

• Exclusion: Exclude all packets that match any of the specified events.   

Step 5 Click OK.  The search then occurs, and the results display.

Find Next
To apply the previous Find parameters to the next search,

Select Find Next under Search on the Menu Bar

OR

Click  on the Tool Bar.
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9.  Reports
The Report menu provides several reports to assist you in analyzing traffic 
recorded by the Analyzer.  

9.1  File Information
To display data on a trace, select Report >File Information from the menu.

The File Information dialog opens and provides information about the 
recording such as when it was made, buffer settings, and version of the 
Analyzer Firmware and BusEngine.
 157



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
9.2  Error Summary
The Error Summary details all errors analyzed throughout the recording.

Step 1 From the Report menu, select Error Summary.

The Traffic Summary window appears with Error information displayed.

Step 2 Navigate to an error within the recording by clicking the 
number of the sequence containing the error.

Step 3 Use the arrows to cycle though each occurrence of a 
particular error.

9.3  Timing Calculations
The Timing  measures timing between any two specified sequences, FIS, or 
markers. The timing calculator feature is designed specifically for tracking 
bus utilization and I/O performance in current or previously captured trace 
files. By default the statistics will be calculated on a complete capture file 
or one bounded between markers or between any two commands, FIS, or 
sequences. You can export these statistics to a .txt file by using the Export 
function in the Timing Calculator screen. In addition to the number of 
commands, the timing calculator provides the following statistics:

• Transfer Rate per second

• Commands per second

• Transfer Size 

• Transfer time

• Bus Idle Time

• Data vs. Overhead (%)

• Data vs. Hold Ratio

To run the Timing Calculator, perform the following steps:
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Step 1 From the Report menu, select Timing Calculations. 

Step 2 Select your calculation criteria from the drop-down list 
boxes, and click the Calculate button.  The results will then 
display in the window.

Step 3 To see the formulas used to calculate the results, click Show 
Formulas.  The following dialog box displays:  
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This dialog includes drop-down menus for Read Commands and Write 
Commands.  These menus are informational only - meaning that they are 
provided so you can see what is meant by the labels "Read Commands" and 
"Write Commands" shown in the Timing Calculator dialog box.

To export Timing Calculator statistics to a text file, 

Step 1 Click the Export button. The Save As dialog appears. 

Step 2 Choose a path and filename, and click Save.

9.4  Traffic Summary
The Traffic Summary displays a report of traffic in the SATracer and 
appears at the bottom of the SATracer main window. The left side contains 
a tree view where you can expand or collapse types of data you want 
displayed to the right of the Traffic Summary window. You can print, e-mail, 
save to disk, or display data in a two-column table by using the buttons in 
the Traffic Summary tool bar. 

From the Report menu, select Traffic Summary. 

Navigating
The Traffic Summary window also functions as a trace navigation tool.  If 
you click one of the numbers in the right side of the window, the trace will 
jump to the first instance of your selection.  Afterwards, click the up or down 
arrows at the top of the Traffic Summary window to navigate forward or 
backward through the display.

Buttons
Buttons at the top of the Traffic Summary window serve to format the 
display and export summarized data to email, file, or the printer:
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The buttons have the following functions:

9.5  Bus Utilization
The Bus Utilization window displays information on bandwidth use.  

To open the Bus Utilization window, select Report >Bus Utilization or 
click the button marked  .  A window opens similar to the one shown 
below:  

Window Layout
The Bus Utilization window divides into two areas:

•   Graph Area - Displays graphs. Initially, no graphs will be 
displayed. To display one or more graphs, click  and make a 
selection from the menu. See “Graph Areas Menu” on page 164 
for an explanation of the types of graphs listed in this menu.

Save As -  Saves Traffic 
Summary results into an 
HTML format

Displays results tabular text format

Email - Creates an email 
with a *.html file attachment 
of the graphs  

Displays drop-down menu with:

Grid Lines - Displays/Hides grid lines

Row Selection - Allows entire rows to be 
selected

Tight Columns - Reformats column widths 
to match data

Print
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• Min/Max/Avg Area - Displays the minimum, maximum, and 
average values for several parameters.  Data is available only 
after you have displayed the relevant graph.  After displaying a 
graph, the Min/Max/Avg information is calculated and is 
thereafter available to the user even if the graph is closed.  The 
user can close this section by clicking  and deselecting 
Statistics Accumulation from the menu. 

Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of 
the displayed data and for exporting data:

The buttons have the following functions:

Save As - Saves the graphs 
as a bitmap file (*.bmp) Vertical zoom in

Email - Creates an email 
with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print

Click and Drag zoom - Click diagonally to 
select and zoom in on part of the graph.  The 
initial direction you begin dragging the 
cursor determines whether the horizontal or 
vertical axis is magnified.

Full Screen Select Range

View Settings - opens a 
sub-menu with options for 
formatting the display. See 
“View Settings Menu” 
below

Sync and Graph areas - If two or more 
graphs are displayed, this button will 
synchronize the graphs to one another.  Once 
synchronized, the positioning slider of one 
graph will move the other graphs

Horizontal zoom in

Graph Areas - Presents a menu of graphs for 
various types of bus data

Horizontal zoom out
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View Settings Menu
Clicking the View settings button  causes a menu 
to open with options for formatting the display.

• Orient Horizontally - changes the 
orientation of bus usage to horizontal.  
After selecting this option, the menu will 
say "Orient Vertically."

• Tile Vertically - tiles the two graphs 
vertically (i.e., side by side).

• Show Markers - Places "tick" marks along 
the x axis of each graph.

• Show Plumb Line - Displays a vertical 
line that connects your cursor to the 
horizontal axis. As the mouse is moved, the status bar will show 
the packet and time frame to which the cursor is pointing.

• Status - Opens a sub-menu with the following options:

— Bar - Displays a status bar at bottom of graph.

— Tooltip - Causes a tooltip to appear if you position your mouse 
pointer over part of the graph and leave it there for a couple of 
seconds.

— None - Turns off tooltips and the status bar.

• Grid Lines - Opens a sub-menu with the following options:

— Both - Displays both X and Y axis gridlines

— X Axis - Displays X axis gridlines

— Y Axis - Display Y axis gridlines

— None - Turns off gridlines

• Grid on Top - Moves the grid lines above the graph.
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• Fonts and Colors - Opens a dialog box for setting the colors and 
fonts used in the graphs:

Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus 
Utilization window. 

Step 1 Click the button.

The Graph Areas menu opens. 

Step 2 Select a graph type from the menu.  Repeat for additional 
graphs.  Menu options are explained in the following table.
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The graph types listed in the menu are as follows:  

Command Explanation

New ... Allows you to create a custom graph.

Statistics accumulation Allows you to display or hide the 
Min/Max/Avg Area on the right side of the 
Bus Utilization window.

Per Sequence Tx Data Payload & Rx Data 
Payload & Hold

Shows for each sequence the number of data 
dwords (Tx or Rx, each one in a different 
color) and the number of HOLD primitives.

Idle Time Between Sequences Displays the time between sequences which 
contain only XXXX, SYNC, and ALIGN 
fields.

Idle Time Between Commands Displays the time between the end of a 
Command and the start of the next one.  
Sequences and FISs that have failed to 
decode into the Command are counted as 
Idle time.  This graph has Min/Max/Avg 
information.

Errors Per Command:  Latency & FIS Length & 
CRC & Invalid State Transition & Disparity & 
Code Violation & R_ERR

Displays the number of errors that occurred 
in the Command.  Each error has its own 
color and place in the graph.

Per Command Tx Data Payload & Rx Data 
Payload & Hold

Displays the data payload of a Command.  
Tx and Rx transfers are shown separately, 
and HOLD count is also shown per 
direction.  HOLD and Payload counts are in 
dwords.  Payload count does not include the 
first data dword.  This graph has 
Min/Max/Avg information.

Time From Command Start to Data (FIS 46) Displays the lapsed time between the start of 
a Command and the first data transfer. If the 
Command does not have any data FIS, the 
amount of time displayed equals the total 
time of the Command.  This graph has 
Min/Max/Avg information.

Time Between Payload Frames:  Max-Tx & 
Ave-Tx & Min-Tx & Max-Rx & Min-Rx

Displays the times between one data FIS and 
the next data FIS for Commands with 
multiple data FIS (46).  This graph shows 
more than one value per Command.  
Min/Max/Avg values are calculated for each 
Command.

Read Cmds Duration & Read Cmds Incomplete 
& Write Cmds Duration & Write cmds 
Incomplete & Other cmds Duration & Other 
Cmds Incomplete

Displays how long this command takes to 
complete.  Also flags incompletes. All split 
into the different command categories.
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Modifying the Appearance of Graphs
To modify a Bus Usage graph, follow these steps below.

Step 1 With a graph displaying in the Graphs Area, right-click 
anywhere in the graph and choose Properties from the 
pop-up menu.   The following dialog box opens.

Step 2 Select an a data type from the box on the left, then edit the 
Title, Appearance, Type, or Color boxes as appropriate.

Step 3 Click OK to apply the changes.

Read cmds tags & Write Cmds Tags & Other 
Cmds Tags

Command usage of tags based on time scale. 
All split into the different command 
categories. Supports 0-31 tags.

Read Cmds LBA & Write Cmds LBA LBA usage per Read and Write commands. 
X axis is the time scale, LBA is the Y axis

Read cmds Ports & Write cmds Ports & Other 
cmds Ports

Port usage per commands. X axis is the time 
scale so port usage can be seen over time. 
All split into the different command 
categories.

FIS Port N Same as the above but in FIS level.

Reg h & DMA Setup & DMA Activate & PIO 
Setup & DATA & reg D & Set Device Bits & 
BIST

FIS types usage over time. X axis is the time 
scale, Y axis is the FIS Type.

Comreset & Cominit & Comwake H & 
Comwake D & & pw mgmt 7 Idle incomp & FIS

Traffic summary over time. This shows the 
different types of bus states over time (OOB 
events, power management, idle, traffic). X 
axis is the time scale, Y axis is the bus state.

Command Explanation
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Creating a New Graph
To create a new graph, 

Step 1 Click .

Step 2  From the menu, select New ... 

The following dialog box will open:

Step 3 From the Title, Appearance, and Type boxes, select the 
desired options.
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10.  Exporting Trace Data
SATracer has export commands that enable you to extract trace data to 
CSV, text and other file formats.  This chapter describes the export process 
for creating CSV and iPek files.

Export commands are accessible through the menu:  File > Export.  The 
Export menu has five options:

• Sequences to Text (Sequence View Format) ...

• Data ...

• 8b/10b

• Sequences to Traffic Generator Text File (.stg) ...

• Comma Separated Data

• Commands to iPeak (.raw)...

10.1  Exporting To Text Format
To export trace data to a text file,

Step 1 Select File > Export > Sequences to Text (Sequence View 
Format) ...

The following dialog box opens. 

Step 2 Select the type and range of traffic to be searched from the 
From and To menus

Step 3 Click OK.

A Save As dialog box opens.
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Step 4 Enter a name for the file and click OK.

The file is then saved.  Exported text files look like this:  

10.2  Exporting Data
SATracer allows you to extract just the data from Sequences, FISs, and 
Commands.  You are given three output choices:  .txt, .dat, and On Screen.

The process is as follows:

To export trace data to a text file,

Step 1 Select File > Export > Data ...

The following dialog box opens. 

Step 2 Select the type and range of traffic to be searched from the 
From and To menus

Step 3 Select the format for export. You have three choices:

Binary - Will extract the data into a binary format

Text - Will extract the data into a text format 
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On Screen - Extracts the data to a dialog box on your screen.  To enable this 
option, select Text.  The On Screen option will then become selectable.

Step 4 Select the remaining options:

Channel - Gives you a choice of saving the traffic from the Host, Device, or Both.

Level - Gives you a choice of the decode level:  Sequence or FIS.

Show Level Data - Displays the decode level in the results.

Step 5 Click OK.

If you have selected On Screen a dialog box will open displaying the extracted 
data.  If you have not selected this box, a Save As dialog box opens.

Step 6 Enter a name for the file and click OK.

The file is then saved.

10.3  Exporting 10b/8b Raw Bits
You can export 8b/10b raw bit codes to a file in a spreadsheet format.  

Step 1 To export raw bits, select File > Export > 8b/10b.  

Step 2 In the following dialog, enter a path and filename. 

Step 3 In the To and From fields choose Sequence or FIS, and 
specify a numeric range.  Or specify Sequence # or Marker. 
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Step 4 Choose a channel: Host, Device, or Both.

Step 5 In the 8B/10B Related fields, select the appropriate 
checkboxes and click Save. See below for descriptions:

• 8Bit - Includes 8-bit values in the export.

• 10Bit - Includes 10-bit values in the export.

• Scrambled Data -Includes the 8-bit binary values in scrambled 
mode. 

• Running Disparity - Includes the RD values as a separate field 
within the export. 

• Hex - Saves hexadecimal values in the *.csv file. 

Note If you export raw 10b or 8b values to a csv file and attempt to 
view the file in a spreadsheet such as Microsoft Excel, these 
applications will automatically strip off the leading zeros from 
each cell/value. Many of the 8b/10b codes will appear with 
missing zero characters. Change Excel’s formatting options to 
pad cell values and correctly display leading zeros. 

See CATC Application Note: Exporting 8b/10b Codes for further 
information: http://www.catc.com/products/support/sup_SATracer.html.

10.4  Exporting to a Traffic Generation Format
Traffic Generation files allow SATrainer to generate Serial ATA traffic.  To 
create a Traffic Generation file, you create or open a trace that has the type 
of traffic you want to generate.  This file will act as a blueprint for traffic 
generation.  You then issue the command:

File > Export > Sequences to Traffic Generation Text File (.stg) ...

SATracer will then export the data it needs for traffic generation.  See 
Section 11., “Traffic Generation with SATrainer” on page 183.

10.5  Overview of Exporting to a .CSV Format
CATC’s SATracer automatically generates over a dozen performance 
metrics for every trace including throughput and average bus free time.  The 
metrics are measured SATracer’s Traffic Summary, Bus Utilization, and 
Timing Calculations dialogs.  SATracer also has the ability, however, to 
extract a far wider range of statistics.  Additional performance data can be 
extracted to a Comma Separated Value (.csv) format where it can be 
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analyzed and measured with a spreadsheet, database or other application.  
SATracer’s Export to Comma Separate Data command lets you extract 
performance trace data.  This section describes the process. In addition, this 
section describes a sample spreadsheet called Performance Analysis.xls 
that is included with the SATracer software.  Performance Analysis.xls 
measures and graphs the .csv file's performance data.  Advanced Excel users 
can develop their own template for graphing performance spreadsheet.

When performing custom analysis using the Export to Comma Separated 
Data feature, SATracer generates metrics by command type. It exports 
these metrics to a single .csv file for every occurrence of the specified 
command. This allow engineers to focus their analysis on the critical I/O 
commands like READ or READ_FPDMA_QUEUED. With all the key 
metrics for a given command  in a single spreadsheet, it's easy to graph and 
display performance over time. 

During the process of exporting trace data to CSV format, users define 
which commands to export; and the order in which fields should appear.  
These settings are stored in an Export Configuration file (.xpt) that is created 
as part of the Export process.  The Export Configuration file can be reused 
in future for other traces.

Summary of the Export Process
Exporting trace file data to Excel is a five-step process:

Step 1 Open a trace and select Commands and Attributes to be exported to 
a .csv file.

Step 2 Save your Command/Attribute settings into a CATC  export-format 
file (.xpt).

Step 3 Export the selected Commands and Attributes from the trace in the 
format specified by the Export file into a .csv file.  

At this point you are done.  

If you would like to see your performance data graphed using a special Excel 
template created by CATC, continue to steps 4 and 5.

Step 4 Start Microsoft Excel and then open the CATC template file 
performance analysis.xls.

Step 5 Open your .csv file.  The .csv file will be formatted and graphed 
automatically and will display performance metrics.
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10.6  Exporting Trace Data to CSV Files
Export to .csv file comprises Steps 1, 2, and 3 from above.  You start by 
identifying the traffic you want exported.  Then you create an Export file 
(.xpt) which arranges the data in the format that you prefer. Lastly, you 
export the data.

Creating an Export File
In your first steps, you open a trace, select and organize Serial ATA 
Commands and Attributes into order you want them in the .csv file, and save 
the configuration as an Export file (.xpt). This Export file preserves your 
field selection and formatting. 

Step 1 In SATracer, open a trace.

Step 2 From the SATracer menu, select File > Export > Comma 
Separated Values > New.  The CSV Export dialog box opens.  
This dialog box lets you select and order the Commands and 
Attributes you want present in your .csv file:

Step 3 Select a range using the From and To boxes.

Step 4 Select one of the checkboxes in the Commands List.  

Step 5 Select the attributes for your selected Command from the 
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checkboxes for the Attributes List on the right.

Note If you select all Commands and Attributes, the Export process 
described later will take a long time.

Step 6 If you wish to re-order the Commands and Attributes differently 
than they appear in the list, use the Move Up or Move Down 
button.

Step 7 Repeat Steps 3 - 5 to select additional commands.

Save Configuration Settings to .xpt File
To preserve your selections into an .xpt file, click the Save As button.  
Pressing Save As causes a directory to be created whose name is 

trace file name + timestamp:

filename_yyyymmmddhhmmss

where yyyy is the year, mmm is the month, dd is the day, hh is the hour, mm 
is the minutes, and ss is seconds. 

Step 1 Click the Save As … button.  A Save As dialog box opens.

Step 2 Enter a file name and location and press Save.  This .xpt file 
can be viewed with an ASCII text viewer such as Notepad.

Note:  After you have created an .xpt file, you can re-open it in the future 
with the SATracer command File > Export > Comma Separated Values 
> Open.

Export Trace Data to .csv File
The Export button exports trace data according to the settings made in the 
open xpt file.

Step 1 Press the Export button.  A browse dialog box opens. 

Step 2 Select a folder where you want to export the file, and click 
OK.  Two files will be created:  a spreadsheet file (.csv file). 
and a data summary file (.txt file).

10.7  Using the CATC Performance Spreadsheet
CATC has created two Export Configuration files (.xpt) and an Excel 
spreadsheet template that are designed to work together.  The Export 
Configuration files cause SATracer to extract key performance data from 
whatever trace is open into a .csv file.  This .csv file is formatted in such a 
way that it easily plugs into a CATC Excel template called performance 
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analysis.xls.  This Excel template has built-in macros and formulas that will 
allow you to view performance metrics within your .csv file.  If you open 
the .csv file in this template, the performance data will be inserted into pivot 
tables and graphed.

Step 1 Open a trace in SATracer.

Step 2 Run the command File > Export > File Separated Data > Open.

Step 3 Navigate to the directory:  
Program Files\CATC\SATracer\CSVExport

Step 4 Select either of the two .xpt files:

• read write performance.xpt 

• selectall.xpt 

Note CATC will add to these .xpt files in future software releases.

Step 5 Click Export.  A browse window opens.

Step 6 Select a directory where you would like to export your data.

Step 7 Click OK.  The dialog box closes.  A .csv file is created and 
placed in a directory called tracename_timestamp.

Step 1 Open Microsoft Excel.

Step 2 Open Performance Analysis.xls.  It resides in:
Program Files\CATC\SATracer\CSVExport

Step 3 A message will appear warning you that the file you are 
opening contains macros.

Note:  If you do not first open the performance analysis.xls template file before 
opening your .csv file, the .csv file will open as an ordinary spreadsheet file and 
will not display any graphs.

Step 4 Click Enable Macros.  You must enable macros in order for 
the spreadsheet to work properly.  After clicking Enable 
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Macros, a browse dialog box opens.

Open Your .csv Spreadsheet File
Step 1 In the browse dialog box, select the .csv file that you created above. 

Step 2 Click OK.  Excel then opens the file.

Excel will display ten tabs along the bottom of the application:

• Export Info - a brief summary of the file

• Data - the raw spreadsheet data

• Average Performance by Seek - graph

• Time to Data by Seek - graph

• Time after Data by Seek - graph

• Average Performance by Data Length - graph

• Performance by Command - graph

• Latency by Seek -graph

• SeekPivot - pivot table

• SizePivot - pivot table

Performance Analysis Spreadsheet Graphs
Graphical displays are primarily useful for identifying trends and 
anomalies. The graphs included in Performance Analysis.xls focus on 
charting Time against Transfer Size or Logical Address. 
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Time to Data Performance
The graphic below shows Time to Data by Logical Seek Distance.  It 
illustrates the elapsed time (in ns) between each WriteDMA command 
being issued to the device and the first Data FIS being returned. The x-Axis 
reflects logical seek distance between the last LBA accessed and next LBA.    

The different bar colors represent Min, Max. and Average Time to Data.  
The example below includes only 19 commands so each point in the graph 
is unique. But in larger datasets the min/max/average are helpful in 
determining if it was a one-time anomaly or a persistent problem. The 20% 
spike in Time to Data  (occurring at logical seek distance of 634723) is 
outside the range of  "normal" command overhead.  It is more likely an 
indication of fragmentation, a media (bad block) or firmware problem.
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Time After Data Performance
The graphic below shows Time After Data by Logical Seek Distance.  This 
illustrates the elapsed time (in ns) between the last Data FIS being returned 
from a WriteDMA command and the next WriteDMA command being 
issued. In this example, the x-Axis also reflects Logical Seek Distance 
between the last LBA accessed and next LBA.  

Time after Data values may increase slightly (higher latency) as the Logical 
Seek Distance increases.  But the spikes in Time After Data measurements 
above could also reflect issues with excessive command overhead at the 
host or drive controller level. The Performance Analysis.xls spreadsheet 
references the actual command number where these spikes occurred making 
further investigation easy.
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Average Performance by Data Length
The graphic below provides an average value for several different metrics 
that illustrate device performance. It provides a different view of the two 
metrics discussed above - oriented around payload size. Plus, it shows 
average transfer time and command completion times with respect to the 
Data Length (in Dwords).    

Average Total Response Time (in ns) illustrates the elapsed time between 
starting and finishing the WriteDMA command using different payload 
sizes.  Obviously, the average Data Transfer time is higher when the 
transaction contains a larger payload. The x-Axis reflects the data length. It's 
easy to see how transfers with larger data payloads (2048 Dwords) are more 
efficient than transfers with smaller data payloads (128 Dwords). This type 
of graph is most useful when measuring identical read/write patterns 
recorded on the same device with different revs of firmware.

10.8  Exporting Commands to iPeak Format
iPeak is an Intel application consisting of a suite of utilities for assessing 
drive performance and workload characteristics.  iPeak uses a .raw file 
format.

To export Commands to iPeak format,

Step 1 Click   to decode to Command Level.
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Step 2 Select File > Export > Commands to iPeak File (.raw) ...

The following dialog box opens. 

Step 3 Select the range of commands to be exported from the From 
and To menus

Step 4 If you know the types of devices that created the traffic in the 
recording, select one of the following categories. You have 
five choices:

• Mass_Storage

• DISK

• CD_ROM 

• DVD 

• TAPE 

Step 5 Click OK.

A Save As dialog box opens.

Step 6 Enter a name for the file and click OK.

The file is then saved with a .raw extension.
 181



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
182



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
11.  Traffic Generation with SATrainer
SATrainer is a traffic generator that can emulate a Serial ATA host or a 
device.  

Traffic generation enables engineers to test designs under realistic 
conditions and to transmit known errors, allowing engineers to observe how 
devices handle faulty link conditions.

SATrainer is supported only by the UPAS 2500H. It is not supported by the 
UPAS 10K.

SATrainer can generate a maximum of 5000 sequences, with a maximum 
sequence length of 50000 dwords.

11.1  SATrainer Hardware
CATC SATrainer requires both the Serial ATA Analyzer module that 
contains the Generator port, and the Serial ATA Generator module that 
plugs into the left slot of the UPAS. SATrainer is then enabled through a 
software license from CATC. When the Serial ATA Generator module is 
installed, the About SATracer... screen will display the text, "Slot B: 
Memory Module." You can access the About SATracer... screen from the 
Help menu.

Two SATrainer Models
There are two models of SATrainer hardware:  

SA003MA - Has three ports marked:  Host, Gen. Out, and Device.  

SA004MA - Has two port marked:  Host and Device.

11.2  Setting Up SATrainer for Host Emulation
SA004MA - Connect the Serial 
ATA cable from the SATrainer 
To Device port to the Host port 
on the unit under test. This 
transmits the Traffic Generator 
stream from the To Device port 
on the SATracer/Trainer to the 
device-side port on the unit 
under test.
 183



 SATracer/Trainer Analyzer User’s ManualCATC SW Version 3.1
SA003MA - Connect the Serial 
ATA cable from the SATrainer 
Gen. Out port to the 
SATrainer Host port. Then 
connect the SATrainer Device 
port to the device-side port on 
the unit under test.  This 
transmits the Traffic Generator 
stream out of the Gen. Out 
port, back in through the Host 
port, and finally out the Device port to the host-side port to the unit under 
test.

11.3  Setting Up SATrainer for Device Emulation
SA004MA - Connect the Serial 
ATA cable from the SATrainer 
To Host port to the host-side 
port on the unit under test. This 
transmits the Traffic Generator 
stream from the To Host port 
on the SATracer/Trainer to the 
host-side port on the unit under 
test.

SA003MA - Connect the Serial 
ATA cable from the SATrainer 
Gen. Out port to the 
SATrainer Device port. Then 
connect the Device port to the 
host-side port on the device 
under test.  This transmits the 
Traffic Generator stream 
through the SATracer/Trainer 
module and back out using the 
host-side port to the unit under test.
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11.4  Generating Traffic
Generating traffic using the SATracer/Trainer is a two step process. First, 
text-based Traffic Generator file must be created. This file can be created 
through a special conversion command in SATracer that converts a trace 
file into a traffic generator file. Alternatively, you can edit an existing file 
or write your own. 

This text file is named with an .stg extension. Once the file has been created, 
in can be opened and displayed in the SATracer application. You can 
invoke the  SATracer application to transmit the traffic generation file by 
using the Traffic Signal button. 

Creating a Traffic Generation File with SATracer
The easiest way to create a Traffic Generation file is to convert an SATracer 
trace file (*.sat) into a *.stg file. This is done with the Export function in 
SATracer.

Step 1 In SATracer, Select File>Export>Sequences to Traffic 
Generator (.stg). The Export to Generator Text screen 
appears.

Step 2 Select Host or Device. 

Step 3 If desired, enter a Max Count for Primitives or aligns.  This 
setting provides you with a way to restrict the count subkey.

Step 4 If desired, select Keep Aligns, Keep Holds etc.

Step 5 Enter the sequence range in the text fields.
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Step 6 Click OK. The Save dialog appears. 

Step 7 Enter a path and filename for the Generator Text file and 
click Save.

A  Generator file (*.stg ) has now been created and can be read with the 
SATracer/Trainer application. A few lines of a File Generator file (shown 
in a text viewer) are illustrated below: 

Opening a Traffic Generation File
Once the Traffic Generation file (*.stg) file has been created, you can then 
open it in the SATracer application.

To open a Traffic Generation file,

Step 1 Select Open under File on the Menu Bar

OR

Click  on the Tool Bar. 
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Step 2 Select a Generator text file (*.stg) and click Open. If needed, 
navigate to the install directory. For samples, see the install 
directory. The Generator file appears in a Trace view, shown 
below:

Start the Recording
Once the .stg file has been loaded, begin the recording.

Step 1 Click  to put the analyzer in Analyzer/Generator mode.

Step 2 Click  to begin the recording.

Power On OOB Sequence
To bring a line into Idle, use the Connect command from the Tool Bar or 
Menu Bar. The Connect button is available as an alternative to embedding 
the Power on OOB sequence directly into the .stg file. It is typically used to 
bring the link up prior to transmitting a traffic pattern (.stg file). 

Select Connect under Generate on the Menu Bar

Or 

Click  on the Tool Bar.

Start Traffic Generation
Once a connection has been established, start traffic generation.

From the Generate menu, select Start Traffic.

Or

Click  on the Tool Bar.
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While generating traffic, a bar appears on the right of the trace view, 
indicating that traffic generation is taking place (The green light on the 
Traffic signal button also blinks during traffic generation).

Stop Traffic Generation
Normally, traffic generation stops automatically when SATrainer reaches 
the end of the Generator file. 

To manually stop traffic generation,

Select Stop Traffic under Generate on the Menu Bar

Or

Click  on the Tool Bar.

Power Off OOB Sequence
To disconnect a line, use the Disconnect command from the Tool Bar or 
Menu Bar. Disconnect is a power off sequence that will cause SATrainer to 
disable its transceiver.

Select Disconnect under Generate on the Menu Bar

Or

Click   on the Tool Bar. 

Using the Spread Spectrum Clock (SSC)
When the SSC is on, SATrainer will use SSC when transmitting data. You 
can turn SSC off in order to test without enabling the SSC receiver or when 
the your design does not support SSC. SATracer/Trainer automatically 
recognizes SSC on the Receive side of transmissions. The default setting is 
on. 
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Note:  SSC On/Off is not currently supported.

When SSC On/Off becomes supported, you turn SSC on by performing the 
following steps: 

Select Generate>SSC On from the Menu Bar. 

Or

Click the  button. 

To turn SSC off,

Select Generate>SSC Off from the Menu Bar.

Or

Click the  button.

11.5  SATrainer File Generation Language
The SATrainer File Generation Language is an API that allows you to 
separate traffic into text commands. These commands are used construct 
primitives that are sent to the host or the device. 

Within the text file each definition consists of a set of assignments that look 
like: key=VALUE. White space is permitted around the equal sign. There 
are no restrictions about dividing definition to lines, and it is not necessary 
to define each new definition in a separate line, although it is recommended. 
The maximum number of characters in a line is 250. The characters '#' and 
';' indicate end-of-line comments (i.e. the rest of the line is ignored). All keys 
and values are case-insensitive, but are shown with keys lower case and 
values upper case for clarity. 

Each Primitive definition starts with one of the assignments: primitive=N 
(where N is a string representing a valid primitive identifier).

Subsequent assignments after a primitive's starting assignment define the 
values of particular fields associated with the primitive. If a field is not 
defined it is defaulted appropriately. 

Values are assumed to be decimal unless they are prefixed with '0x' and then 
are interpreted as hexadecimal. Values within a block assignment are 
always assumed to be hexadecimal and should not be prefixed by '0x'. 

Some level of syntax and bounds checking is done when the file is parsed 
for displaying, and then again upon downloading.

The following tables contain support keys for defining fields within a 
sequence:
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File Control Keys
File Control Keys are session based instructions for setting up a stream. 
They can only be used at the beginning of a file. These keys determine the 
direction of the stream, whether it is going to the device or the host.

Configuration Control Keys
Configuration keys are localized commands that control the behavior of the 
Serial ATA traffic based on where you put these commands in the stream. 
These commands customize traffic behavior and how it transmits or 
handshakes.

Table 2: File Control Keys

Key Code Format Description

file_type This must be included at the beginning of the file to 
determine the hardware platform the file was created for. 
This key can only be used in the beginning of the file 
before the first sequence. 

file_version integer This must be included after the "file_type=" key to 
determine the version of this file. Value is currently 1. 
This key can only be used in the beginning of the file 
before the first sequence.

file_speed This must be included after the "file_version=" key to 
determine the speed of primitives to be generated. Only 
one "file_speed" is allowed per .stg file. This key can 
only be used in the beginning of the file before the first 
sequence.

stop If you want to run only some first portion of the 
beginning of a .stg file, insert this statement where you 
want generation to halt. This saves having to edit a file 
into smaller files when testing a portion of traffic.

Table 3: Configuration Control Keys

Key Code Format Description

Begin_config HERE Defines the beginning of the region in the file used to 
configure the generated traffic. Can appear either in the 
beginning of the file or during an idle time (after sync) on 
the bus. 

Prev_rd Pos/Neg Defines the running disparity polarity before the traffic 
from this file. It is used to generate the 10b code for the 
first 8b code. This key can only be used in the beginning 
of the file before the first sequence.

Traffic_dir Host/Device Sets the direction of the generated traffic. This key can 
only be used in the beginning of the file before the first 
sequence.
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auto_align False/True Defines if the software should generate ALIGN's 
automatically. Default is FALSE.

Fields:

• per_burst - Default is 2.

• between_bursts - Default is 254.

• offset_to_first_burst - Default is 0.

This key can only be used in the beginning of the file 
before the first sequence.

auto_align_hw True/False When enabled, the SATrainer inserts a pair of Aligns 
every 254 dwords in idle time. Default is TRUE.

auto_oob True/False Responds to OOB sequence automatically. Default is 
TRUE. This key can be used either in the beginning of 
the file or during an idle time on the bus (after a SYNC 
SYNC CONT).

end_config Here Terminates the configuration region. This key can be 
used either in the beginning of the file or during an idle 
time on the bus (after a SYNC SYNC CONT).

Begin_oob Here This defines the beginning of the region defining OOB 
negotiation.

Com_reset_init (value value  
value value)

Fields (in hex): 

• per_burst - number of aligns per burst. Default is 4.

• Number_of_bursts - Default is 3.

• Time_between_bursts - time in dwords (26.6ns) 
between bursts. Default is 320 ns.

• Time_after_last - time in dwords (26.6ns). Default is 
525 ns.

Com_wake (value value  
value value)

Fields (in hex): 

• per_burst - number of aligns per burst. Default is 4.

• Number_of_bursts - Default is 3.

• Time_between_bursts - time in dwords (26.6ns) 
between bursts. Default is 160 ns.

• Time_after_last - time in dwords (26.6ns). Default is 
175 ns.

D102_align (value value) Fields:

• Align_count - Number of Aligns to generate after 
d10.2 burst

• D10.2_count - Number of d10.2 dwords to generate

Used only when auto_OOB is off. 

end_oob Here Terminates the OOB region. 

Auto_handshake TRUE

FALSE

Allows hosts and devices to  synchronize at the primitive 
level.

Table 3: Configuration Control Keys

Key Code Format Description
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Bus Condition Keys
Bus Condition keys are used to selectively introduce bus condition 
signalling within the SATrainer traffic stream. This allows the user to 
transmit out-of-band signaling like COM RESET or COMWAKE 
programmatically anywhere in the traffic file. 

Bus Condition keys are influenced by OOB Configuration and Control 
Configuration keys, which let the user define how the SATrainer will 
behave when it receives and transmits out-of-band signals from host or 
device.  

Table 4: Bus Condition Keys

Primitive Keys
Primitive Keys are the basic building blocks of all Serial ATA traffic. 

Key Code Format Description

Bus_condition Comreset/com
init/comwake/
connect/disco
nnect/oob_ali
gn/oob_d10.2

The different Bus conditions will behave according to the 
specs defaults, unless specified differently in the OOB 
configuration section. Connect is used together with 
auto_oob to bring the line up (full OOB sequence). 

After a disconnect, it is recommended to add an Idle 
block to specify how long the lines should remain in idle. 
The next command will be transmitted after this idle 
time, and if there is no other command the lines will stay 
disconnected.

This key also controls the synchronization stage at the 
end of OOB. The trainer will transmit the align/d10.2 
primitives based on the given count value.

Idle integer Idle time in ns count (+-13.3 ns)  max is 666000 (< 666 
micro sec).
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Table 5: Primitive Keys
Key Code Format Description

primitive _id string or 32 
bits

Use this as the primitive to be sent. The key should be 
assigned to a valid primitive identifier string per the 
Serial ATA specification: ALIGN, CONT, DMAT, 
EOF, HOLD, HOLDA, PMACK, PMNAK, 
PMREQ_P, PM_REQ_S, R_ERR, R_IP, R_OK, 
R_RDY, SOF, SYNC, WTRM, X_RDY. Optionally, 
you can assign this key a raw 32 bit value.

Fields:

• count - number of primitives to transmit - Default is 1. 
Maximum count is 10000.

• prd - sets the previous rd sign (used to generate the 
10b code) (POS/NEG).

• rd_error - forces an rd error  (value == TRUE).

Data 32 bits Fields:

• prd - sets the previous rd sign (used to generate the 
10b code) (POS/NEG).

• rd_error - forces an rd error (value == TRUE).

• control - using a 4 bits mask, sets one of the 8 bits 
code  so that it will translate into a 10b control code.

auto_data (value value 
value)

Fields:

• initial_data - for incremental data.

• count - number of dwords to add - default 1·step - step 
between each value.

Xxxx 32 bits or 
Auto

Generates garbage traffic (after CONT) on the bus.

Field:

count - number of dwords to add default 1 Max count is 
10000. Example:

xxxx=value 

cont=n

crc 32 bits or auto This is the crc value for the previous data.

• prd - sets the previous rd sign (used to generate the 
10b code) (POS/NEG).

• rd_error - forces an rd error (value == TRUE).

• crc_error - force a crc error.

raw_data 40 bit values 
in hex 
(ff ff ff ff ff)

Raw data to be generated on the bus.

raw_data_10b 40 10-bit 
values in Hex 
(3ff 3ff 3ff 
3ff)

Raw data to be generated on the bus.

marker “string” A description for the current sequence (once per 
sequence).
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11.6  Configuration Behaviors
A configuration section starts with a begin_config=here and ends with 
end_config=here.

Session configuration
These settings are only accepted in the beginning of the file.

Localized configuration
Note - Localized configuration is accepted only during idle time on the bus.

prev_rd Sets the initial running disparity. This running disparity is used to 
generate the 10b code of the first transmitted primitive.

traffic_dir Sets the direction of the generated traffic.

auto_align If set, you can get the software to add Aligns into the generated stream 
(based on the parameters of this command).

auto_oob When enabled, SATrainer will:

• React automatically to OOB commands issued by the tested Device 
or Host. After the OOB sequence the generator will continue from the 
last place, though the context may be lost due to the unexpected OOB 
signaling.

• Wait for OOB responses before continuing the OOB flow.

When enabled, SATrainer will:

• Ignore OOB commands issued by the tested Device or Host.

• Follow user commands while transmitting OOB flow. 

Auto_align_hw When enabled, SATrainer will insert Aligns into stream (2 every 254 
dwords)

When enabled, SATrainer will:

• If auto_handshake is set: only insert Aligns during Idle times, if 
necessary.

• If auto_handshake is unset: do nothing.

OOB Configuration A configuration section has to start with a begin_oob=here and ends 
with end_oob=here.

OOB configuration is accepted only during idle time on the bus.

The following keys let the user define attributes of the OOB commands. 
SATrainer will use these attributes when generating OOB commands. If 
no attributes are defined, SATrainer will use the default set from the 
specification.

• com_reset_init - based on the traffic direction, this set the attributes 
of COMRESET (Host traffic) or COMINIT (Device traffic).

• com_wake - sets the attributes of COMWAKE.
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Primitives Configuration

OOB Configuration

Idle Configuration

ALIGN You either generate ALIGN primitives using the primitive_id key or 
use the auto_align key to so automatically. During Idle time on the bus 
if auto_alignw is set, the hardware will insert aligns into the generated 
stream (in 254 dwords intervals).

COMRESET When auto_oob is set, SATrainer will transmit the COMRESET and 
then wait until COMINIT is received. When auto_oob is unset, 
SATrainer will transmit the COMRESET and continue to the next 
command.

COMINIT When auto_oob is set, SATrainer will wait for COMRESET before 
transmitting COMINIT and then wait until COMWAKE is received. 
When auto_oob is unset, SATrainer will transmit the COMINIT and 
continue to the next command.

COMWAKE When auto_oob is set, SATrainer will transmit COMWAKE and then 
wait for until COMWAKE is received. When auto_oob is unset, 
SATrainer will transmit the COMWAKE and continue to the next 
command.

CONNECT When auto_oob is set, SATrainer will transmit full OOB sequence until 
the line is Idle.

DISCONNECT SATrainer will disconnect the line.

OOB_ALIGN SATrainer will transmit a stream of ALIGN based on the given count in 
D10.02_align.  If auto_oob is set, the stream will be stopped when line 
is synchronized and not based on count.

OOB_D102 SATrainer will transmit a stream of D10.2 based on the given count  
based on the given count in D10.02_align. If auto_oob is set, the stream 
will be stopped when ALIGNs will be received on the other line.

IDLE Insert idle time in ns (-+13.3ns).
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Inserting Errors 

crc error Use the crc key to write a specific wrong crc value or use the crc_error 
= true attribute.

scrambling error Insert raw data (raw_10b) in the data stream or reset the scrambler seed 
in the middle of the data.

align error Insert aligns primitives in wrong places in the stream.

running disparity error Use the raw_10b key to insert running disparity errors or set an rd error 
using the prd or rd_error sub keys.

code violation Insert a wrong code using the data or raw_data keys.

protocol error • fis length - create a mismatch between fis type and length.

• fis type - use an illegal type in the data stream.

• fis direction - use a fis in the wrong direction.

• invalid state transition - use any wrong primitive combination.
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11.7  Generator File Structure
The following shows the general structure of a Generator file (.stg):
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Appendix A:  Specifications
SATracer/Trainer is a hardware module that installs into the Universal 
Protocol Analyzer System. The following specifications describe a 
combined SATracer/Trainer/Universal Protocol Analyzer System. 

Package

Power Requirements
90-254VAC, 47-63Hz (universal input), 120W maximum 

Environmental Conditions 

Switches 

LEDs 

Connectors: UPAS AC power connection
External trigger connection (TRIG IN/OUT, BNC)
PC connection (USB 2.0 Hi-Speed, type "B")
SATracer Plug-in Recording Channel

Operating Range: 0 to 55 °C (32 to 131 °F)
Storage Range: -20 to 80 °C (-4 to 176 °F)
Humidity: 10 to 90%, non-condensing

Power: On/off
Manual Trigger: When pressed, triggers the end of the recording

UPAS: Illuminated when the analyzer is powered on.
Status (STATUS): Illuminates for approximately 25 seconds during initializa-

tion/power up of the UPAS base unit. If this LED blinks 
following initialization, this is an indication that initializa-
tion failed.

Recording (REC): Illuminated when the analyzer is actively recording traffic 
data

Triggered (TRG): Illuminated during power-on testing and when the analyzer 
has detected a valid trigger condition.

UPloading (UPLD): Illuminated when the analyzer is uploading its recording 
memory to the Host PC for displaying the CATC trace

SATracer Plug-in 
Module:
Status (STATUS): Illuminates when there is traffic on both the host and device 

sides.
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Probing Characteristics

Recording Memory Size 
512 M x 8-bit DRAM for traffic data capture, timing, state and other data.

Connection: Serial ATA Signal Cable receptacles
Standard cables (up to 1 meter in length)

Frequency: 1.5 gigahertz +/- 220 ppm
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Basic Trigger Events
Primitives: SYNC, X_RDY, WTRM, ALIGN, R_RDY, R_IP, R_OK, 

R_ERR, SOF, HOLD, HOLDA, DMAT, PMREQ_P, 
PMREQ_S, PMACK, PMNAK, EOF, CONT

Bus Conditions: COMRESET, COMINIT, COMWAKE HOST, COM-
WAKE DEVICE, CONNECT, DISCONNECT

FISs: Register-Host to Device, REgister Device to Host, DMA 
Activate, DMA Setup, BIST Activate, PIO Setup, Data, Set 
Device Bit

Errors: FIS Length Error, FIS Type Error, CRC Error, Disparity 
Error, Align Error, Code Violation Error
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Commands Execute Device Diag, Device Reset, CFA Erase Sectors, 
CFA Request, Ext Error Code, Check Power Mode, Flush 
Cache, Flush Cache Ext, Get Media Status, Idle, Idle 
Immediate, Initialize Device Params, Media Eject, Media 
Lock, Media Unlock, Nop, Read Native Max address, Read 
Native Max address Ext, Read Verify Sectors, Security 
Erase Prepare, Security Freeze Lock, Seek, Set Features, 
Set Max Address, Set Max Address Ext, Set Multiple 
Mode, Sleep, Smart, Standby, Standby Immediate, CFA 
Translate Sector, Identify Device, Identify Packet Device, 
Read Buffer, Read Multiple, Read Multiple Ext, Read 
Sectors, Read Sectors Ext, CFA Write Multiple wout Erase, 
CFA Write Sectors Wout Erase, Download Microcode, 
Security Disable Password, Security Erase Unit, Security 
Set Password, Security Unlock, Write Buffer, Write 
Multiple, Write Multiple Ext, Write Sectors, Write Sectors 
Ext, Read DMA, Read DMA Ext, Write DMA, Write DMA 
Ext, Packet, Service, Read DMA Queued, Read DMA 
Queued Ext, Write DMA Queued, Write DMA Queued 
Ext, Read Stream SMA, Read Stream PIO, Read Log Ext, 
Write Stream DMA, Write Stream PIO, Write Log Ext, 
Read Verify Sectors Ext, Configure Stream, Device 
Configuration, Check Media Card Type, Smart Read Data, 
Smart Read Log, Smart Write Log, Smart Enable 
Operations, Smart Disable Operations, Smart Return 
Status, Smart Execute Off Line, Smart Enable Disable 
Autosave, Smart Save Attribute, Device Config Freeze 
Lock, Device Config Identify, Device Config Restore, 
Device Config Set, Read SFO, Write SFO, SEP ATTN, 
Read FPDMA Queued, Write FPDMA Queued, 
Recalibrate, Format Track, Identify Device DMA, Read 
DMA Without Retries, Write DMA Without Retries, Read 
Sectors Without Retries, Write Sectors Without Retries, 
Read Long, Read Long Without Retries, Write Long, Write 
Long Without Retries, Write Verify, Write Verify Without 
Retries, Read Verify Without Retries
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How to Contact CATC

Limited Hardware Warranty
So long as you or your authorized representative 
("you" or "your"), fully complete and return the 
registration card provided with the applicable 
hardware product or peripheral hardware products 
(each a "Product") within fifteen days of the date of 
receipt from Computer Access Technology 
Corporation ("CATC") or one of its authorized 
representatives, CATC warrants that the Product 
will be free from defects in materials and 
workmanship for a period of three years (the 
"Warranty Period").  You may also complete your 
registration form via the internet by visiting 
http://www.catc.com/support/register/.  The 
Warranty Period commences on the earlier of the 
date of delivery by CATC of a Product to a common carrier for shipment to you or 
to CATC's authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, 
damage during shipment after delivery to a common carrier by CATC, abuse, 
misuse, problems with electrical power, including power surges and outages, 
servicing not authorized by CATC, usage or operation not in accordance with 
Product instructions, failure to perform required preventive maintenance, software 
related problems (whether or not provided by CATC), problems caused by use of 
accessories, parts or components not supplied by CATC, Products that have been 
modified or altered by someone other than CATC, Products with missing or altered 
service tags or serial numbers, and Products for which CATC has not received 
payment in full.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600

Fax your questions… Worldwide: 1 (408) 727-6622

Write a letter… Computer Access Technology Corp.
Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

Send e-mail… support@CATC.com

Visit CATC’s web site… http://www.CATC.com/
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Coverage During Warranty Period

During the Warranty Period, CATC or its authorized representatives will repair or 
replace Products, at CATC's sole discretion, covered under this limited warranty 
that are returned directly to CATC's facility or through CATC's authorized 
representatives.

How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report 
your covered warranty claim by contacting CATC Technical Support or its 
authorized representative.  

CATC Technical Support can be reached at 800-909-7112 or via email at 
support@catc.com.  You may also refer to CATC's website at http://www.catc.com 
for more information on how to contact an authorized representative in your region.  
If warranty service is required, CATC or its authorized representative will issue a 
Return Material Authorization Number. You must ship the Product back to CATC 
or its authorized representative, in its original or equivalent packaging, prepay 
shipping charges, and insure the shipment or accept the risk of loss or damage 
during shipment. CATC must receive the Product prior to expiration of the 
Warranty Period for the repair(s) to be covered.  CATC or its authorized 
representative will thereafter ship the repaired or replacement Product to you freight 
prepaid by CATC if you are located in the continental United States.  Shipments 
made outside the continental United States will be sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. 
CATC does not accept liability for lost or damaged peripheral accessories, data or 
software.

CATC owns all parts removed from Products it repairs. CATC may use new and/or 
reconditioned parts, at its sole discretion, made by various manufacturers in 
performing warranty repairs. If CATC repairs or replaces a Product, the Warranty 
Period for the Product is not extended.

If CATC evaluates and determines there is "no trouble found" in any Product 
returned or that the returned Product is not eligible for warranty coverage, CATC 
will inform you of its determination.  If you thereafter request CATC to repair the 
Product, such labor and service shall be performed under the terms and conditions 
of CATC's then current repair policy.  If you chose not to have the Product repaired 
by CATC, you agree to pay CATC for the cost to return the Product to you and that 
CATC may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU 
MAY HAVE ADDITIONAL RIGHTS THAT VARY BY JURISDICTION.  
CATC'S RESPONSIBILITY FOR DEFECTS IN MATERIALS AND 
WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT AS SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS 
EXPRESSLY STATED IN THIS WARRANTY STATEMENT, CATC 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY 
PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES THAT 
MAY ARISE FROM ANY COURSE OF DEALING, COURSE OF 
PERFORMANCE OR TRADE USAGE.  SOME JURISDICTIONS MAY NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

CATC DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, 
ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST YOU FOR 
DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST 
DATA OR SOFTWARE.  CATC'S LIABILITY TO YOU MAY NOT EXCEED 
THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE SUBJECT OF 
A CLAIM.  SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 
PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the 
then current owner transfers ownership of the Product and notifies CATC of the 
transfer.  You may notify CATC of the transfer by writing to Technical Support at 
Computer Access Technology Corporation, 3385 Scott Blvd., Santa Clara, CA 
95054 USA or by email at: support@catc.com.  Please include the transferring 
owner's name and address, the name and address of the new owner, the date of 
transfer, and the Product serial number.
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